
  Installation and User’s Guide 
Omneon ProDrive™ 

  Release 1.2 



ii Installation and User’s Guide

  

Omneon, Inc. • ProDrive™ • Installation and User’s Guide 

Part Number: 28-0287. Release 1.2. January 2011.

Copyright and Trademarks

This User's Guide is the property of Omneon, Inc. or its licensors and is protected by copyright law: Copyright 
© 2011 Omneon, Inc.  All rights reserved. Omneon, ProDrive, Omneon, Inc., and the Omneon logo are 
trademarks of Omneon, Inc..  All other trademarks are the property of their respective holders. May be covered 
by one or more of U.S. Patents No. 6,571,351; 6,696,996; 6,545,721; 6,574,225; 6,895,003; 6,522,649; 6,643,702; 
foreign counterparts and pending patent applications. 

The software which accompanies this User's Guide is the property of Rascular Technology Ltd. or its licensors 
and is protected by copyright law.  This software is licensed by Omneon to you pursuant to a license agreement 
between Rascular Technology, Ltd ,and Omneon, Inc.  Your use of the  software is governed by the end user 
license agreement set forth in any one of the following locations: the shrink wrap license presented upon 
installation of the software or in the About section of the software, online at http://www.omneon.com, or by 
contacting us at support@omneon.com.  Unless otherwise agreed between you and Omneon, your installation 
of the Software constitutes acceptance of the license agreement. 

Software Release

Release 1.2

Notice

Information contained in this guide is subject to change without notice or obligation. While every effort has 
been made to ensure that the information is accurate as of the publication date, Omneon, Inc.. assumes no 
liability for errors or omissions. In addition, Omneon, Inc.. assumes no responsibility for damages resulting 
from the use of this guide.

Company Address

Harmonic, Inc.

4300 North First Street

San Jose, CA 95134  U.S.A.

Telephone (Toll Free): +1(888) OVN SPT1 (686 7781)

Telephone (Local): +1(408) 585 5200

Fax: (408) 521 2191

E-mail: support@omneon.com

http://www.omneon.com/service-support

ftp://ftp.omneon.com/Updates/Omneon/Current/

http://www.omneon.com
mailto:support@Omneon.com
http://www.Omneon.com/service-support
ftp://ftp.omneon.com/Updates/Omneon/Current/


Contents
Chapter 1: Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
About Omneon ProDrive. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Powerful Ingest Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Flexible Clip Preparation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Extensive Playout Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Manage Clips Easily . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Understanding the ProDrive Overview Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Status Panels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Players Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Locating the Latest Documentation on the Omneon Web Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Technical Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Chapter 2: Installing ProDrive. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11
In this Chapter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
System Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
System Compatibility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
What Gets Installed. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Installing ProDrive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
About ProDrive Licensing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Obtaining a Valid License . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
About the Omneon Media API DLL and ProDrive. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Chapter 3: Configuring ProDrive  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
In this Chapter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Starting ProDrive  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Configuring a Media Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Limiting Access to the ProDrive Configuration Screens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Customizing the Appearance of Events  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Assigning Roles to Players  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Disabling a Player for Use With ProDrive. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
About Configuration and Log Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
ProDrive™ Release 1.2 iii



  Contents
Chapter 4: Performing a VTR Ingest  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
In this Chapter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Enabling a Player for VTR Ingest  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Configuring a COM Port for VTR Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Understanding the VTR Ingest Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Understanding the VTR Ingest List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Managing VTR Ingest Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Creating VTR Ingest Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Opening VTR Ingest Lists. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Clearing VTR Ingest Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

Managing Clips in VTR Ingest Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Adding Clips to a VTR Ingest List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Editing Clips in a VTR Ingest List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Deleting Clips from a VTR Ingest List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Cueing Clips in a VTR Ingest List. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Managing a VTR Ingest  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Running a VTR Ingest . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Skipping to the Next Clip  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Stopping a VTR Ingest  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Rerunning a VTR Ingest  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Chapter 5: Performing a Scheduled Ingest . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Understanding the Scheduled Ingest Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Enabling a Player For Scheduled Ingest  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Managing Scheduled Ingest Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Assigning a Scheduled Ingest List for a Player . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Clearing Scheduled Ingest Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
Saving Scheduled Ingest Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Managing Scheduled Ingest Events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
Adding Events to a Scheduled Ingest List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
Editing Events in a Scheduled Ingest List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Deleting Events in a Scheduled Ingest List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Chapter 6: Preparing Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
In this Chapter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
iv Installation and User’s Guide



  Contents
Understanding the Clip Preparation Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Enabling a Player for Clip Preparation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Managing Clips and the Clip Prep List. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

About Opening Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Adding Clips to the Clip Prep List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Updating Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Loading Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Creating New Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Flattening Clips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Recording Clips (Crash Record)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
Ejecting Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Clearing Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

Chapter 7: Playing Out Clips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
In this Chapter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Enabling a Player for Playout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Understanding the Playout Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

Understanding the Playout List Text File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Managing Playlists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

Opening Playlists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Appending Playlists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Saving Playlists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Clearing Playlists. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
About Status Updates to the Playlist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

Managing Playout Events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
Creating Playout Events. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
Editing Playout Events  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
Copying and Pasting Playout Events  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
Cutting Playout Events  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
Deleting Playout Events  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
Selecting All Playout Events  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

Playing Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

Chapter 8: Managing Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
In this Chapter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Omneon, Now Part of Harmonic v



  Contents
Understanding the Clip Management Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

Viewing Clips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
Filtering Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
Viewing Clips in a Folder. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100
Viewing Clip Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

Managing Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
Selecting Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Sorting Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Renaming Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Copying Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Moving Clips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Deleting Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Changing to Complex View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104

Adding Custom Metadata to Clip User Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
Managing Clip Folders  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107

Exploring Folders. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
Creating Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
Renaming Folders  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Refreshing Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Deleting Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

Appendix A: Reference Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .111
Clip Preparation Keyboard Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
VTR Keyboard Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
List Control Keyboard Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
About ProDrive.exe Error Messages and Logs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114
About the As-Run Log Header List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
About Authentication for Omneon MediaDirector 2202 Systems Working with ProDrive  . . . . . . 116
About Fault Handling in ProDrive  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
About the Automatic Renaming of Sub Clips Using Clip Patterns . . . . . . . . . . . . . . . . . . . . . . . . . . 118

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
vi Installation and User’s Guide



CHAPTER 1
Introduction
This guide provides information on how to install and use the Omneon ProDrive application. Choose 
from the following sections:

• About Omneon ProDrive

• Understanding the ProDrive Overview Window

• Locating the Latest Documentation on the Omneon Web Site

• Technical Support

About Omneon ProDrive

Omneon ProDrive™ is an integrated media control system for Omneon Spectrum™ System and 
MediaDeck™ broadcast servers, combining ingest, preparation, and clip playout functions for up to 
six broadcast channels into a single application. 

Omneon ProDrive
ProDrive™ Release 1.2 1
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Using ProDrive, you can:

• Control content on your Spectrum or MediaDeck server from anywhere on the network

• Capture content  according to a schedule, or use the crash record feature

• Capture content from tapes while simultaneously controlling the source VTR via serial protocol

• Create playout schedules

• Review clips, specify in and out points, and create sub-clips, all from your desktop – or rename, 
move, copy and delete content 

ProDrive supports from one to six simultaneous playout or ingest ports, providing true flexibility to 
configure the system to meet your requirements. 

ProDrive can be installed on any PC computer running Windows XP® or Windows Vista with 
TCP/IP connectivity to a Spectrum or MediaDeck server.

Powerful Ingest Features

ProDrive provides a range of ingest features for capturing content to your Omneon Spectrum Server 
or Omneon MediaDeck and preparing it for transmission. 

The Crash record feature allows operators to instantly specify capture content that is being fed to a 
port. Crash records can run for a specified duration to create a clip on your server.. Clips can then be 
scheduled for playout on another port while being recorded. 

ProDrive’s schedule management feature enables users to view, edit and create new scheduled record 
items at any time of day for any duration. At the specified time, your server will  switch to record 
mode and capture your desired content. 

VTR Ingest allow you to capture content from your tapes while simultaneously controlling the source 
VTR via serial protocol. With VTR Ingest, you can create an ingest list based on the content of a tape, 
and then  capture and digitize all marked sections from that tape. This feature captures content from 
multi-segment tapes and handles long-form content that spans multiple tapes. Ingest lists can also be 
created in external applications and imported into ProDrive.
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VTR Ingest

Flexible Clip Preparation

ProDrive provides comprehensive clip preparation to ensure that the content stored on your Server or 
Omneon MediaDeck is ready for transmission whenever you need it. 

Any clip on your server can be loaded into the ProDrive application and controlled just as if it were a 
clip on a VTR, using any appropriately configured port on your server. Operators can jog and shuttle 
through the clip, find points of interest, mark new in and out points, and create new sub-clips based 
on this data.
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Clip Preparation

Extensive Playout Options

ProDrive provides comprehensive content playout features in the same intuitive user interface. 
Individual clips (or even sections of clips) can be loaded onto a port and either played out immediately 
or scheduled for playout at a specific time. 

Operators are also able to create playout lists containing multiple clips from your server. ProDrive 
supports complex transmission rules such as list looping, configuring Auto-follow, Manual, or Hard-
timed Events. New clips arriving on the server can immediately be inserted into an active list at any 
desired location within the list. 

ProDrive can also import playlists from Omneon PlayTool, making it easy to integrate into existing 
workflows or other parts of your business. 

Full logging of transmission output is provided, making it easy to compare schedules and as-run 
content – ensuring that what went to air matches what was intended. 
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Clip Playout

Manage Clips Easily

The clip management features in ProDrive help you to manage the content stored on your server. . 
With a full explorer view of the server’s contents, you can rename, move, copy and delete clips, all 
from your desktop. Even with complex reference or self-contained clips, a consolidated view makes 
your content manageable and accessible. Folder structures within the server can also be created and 
organized with ProDrive.

Clip Management
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Summary

Paired with the Omneon server of your choice, ProDrive provides a complete solution to get you on 
air quickly and painlessly. Fast to set up and easy to learn and use, it is the ideal companion for your 
Spectrum or MediaDeck Server.

Understanding the ProDrive Overview Window

When the ProDrive application starts, the Overview window displays. This window contains access to 
all ProDrive configured Players as well as Clip management.

The Overview window is arranged into different groups of controls and displays. From top to 
bottom, these are the Menu bar, the Players bar, and the Status Panel area.

Status Panels

As you configure Players in ProDrive, panels are added to the Overview window. The panels provide a 
quick status of all functions currently in operation in ProDrive.

Menu Bar

Players 
Bar

Configured 
Ports

Free Space on 
Server

System 
Timecode

Status 
panels
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Players Bar

The Players bar, which appears at the top of the Overview window, provides access to all ProDrive 
functions. The Overview and Clip Management buttons always appear in the window. Other buttons, 
one for each configured Player, only appear after you configure that Player for a specific role of either 
Playout, VTR Ingest, Clip Prep, or Scheduled Ingest. The buttons can be configured with a name and 
graphic of your choice.

Table 1.  Overview—Panels 

Shows the status of each port (OK, Error, or Warning) 
and a description of the state (idle, playing, or recording). 

When active, clip names and timecodes are also 
displayed. If the status is Error or Warning, a brief 
description of the problem is shown. For playout 
channels, the next clip (if any) is shown below the 
current clip. 

Indicates the process is idle.

Indicates a normal operating condition.

Indicates record stop button. This button is only 
available for scheduled ingest.

Indicates a Warning condition that requires user 
intervention. For example, in a Playlist, an item may be 
cued but the Take button needs to be clicked. In a VTR 
Ingest, the Warning may be issued when you need to 
change reels. 

Indicates an Error condition that requires user 
intervention. For example, in a Playlist, the clip for the 
next event may be missing. In a VTR Ingest, the Warning 
may be issued because an ingest failed to occur, or the 
ingest was invalid.

Shows the free space on the media server. This value is 
base on the configuration of the Players and is shown as 
a percentage of the total storage available. 

Shows the system timecode in HH:MM:SS:FF 
(hours:minutes:seconds:frames).

Shows the current date and time according to the media 
server.
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Menus

Overview List Buttons Sort Order

The top row buttons, Overview List buttons, and Player configuration tabs display alphabetically 
based on the user defined name. Alphabetizing follows the standard Microsoft rules. For more details, 
go to: http://msdn.microsoft.com/en-us/library/bb759947(VS.85).aspx. Symbols sort in 
ASCII sort order and display before numbers in a list. See http://www.asciitable.com. See Table 4 
for an example of the sorting order.

Table 2.  Overview— Default Buttons

Displays the Overview window which provides access to all ProDrive 
configured Players as well as media management.

Displays the Clip Management window which provides the following 
functions:

• Ability to view the server’s file system
• Create, rename, move, copy, and delete directories
• Rename, move, copy, and delete clips

Table 3.  Overview—Menus

File • Exit—closes ProDrive and exits the application.

Tools • Configuration— opens a system setup window for ProDrive
• VTR Control—opens a VTR transport control window for VTRs connected 

to the PC serial com port(s)
• View Log—displays the event log at the bottom of the window.

Help • About—provides license and build information about the installed ProDrive 
release.

Table 4.  Overview—List Buttons Sorting Order Example

The following items: Are sorted as follows:
A standard string would 

sort as follows:

1984 
3M Company 
007 James Bond 
101 short stories 
600 new churches 
3-D movies 

3-D movies 
3M Company 
007 James Bond 
101 short stories 
600 new churches 
1984

007 James Bond 
101 short stories 
1984 
3-D movies 
3M Company 
600 new churches
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Locating the Latest Documentation on the Omneon Web 
Site

The latest product technical documentation, as well as information provided for older releases, is 
available at:

http://www.omneon.com/service-support/documentation.php

Technical Support

Omneon provides many ways for you to obtain technical support. In addition to contacting your 
Distributor, System Integrator, or Omneon Account Manager, you can contact the Omneon Technical 
Support department as follows:

For support in the Americas:

• Telephone (Toll Free): +1(888) OVN SPT1 (686 7781)

• Telephone (Local): +1(408) 585 5200

• Fax: (408) 521 2191

• Email: support@omneon.com

• http://www.omneon.com/service-support

• ftp://ftp.omneon.com/Updates/Omneon/Current/

For support in Europe, Middle East, and Africa:

• Telephone: +44 1252 555 450

• Fax: +44 1252 377 171

• Email: emeasupport@omneon.com

• http://www.omneon.com/service-support

• ftp://ftp.omneon.com/Updates/Omneon/Current/

For support in Russia and CIS

• Telephone Number: +7 495 506 5981

• Fax: +7 495 937 8290

• Email: RUsupport@omneon.com

• http://www.omneon.com/service-support

• ftp://ftp.omneon.com/Updates/Omneon/Current/

For support in Japan:

• Telephone: +81 3 5565 6737 

• Fax: +81 3 5565 6736 
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• Email: japansupport@omneon.com

• http://www.omneon.com/service-support

• ftp://ftp.omneon.com/Updates/Omneon/Current/

For support in China (mainland):

• Telephone: +86 10 8391 3313

• Fax: +86 10 8391 3688

• Email: chinasupport@omneon.com

• http://www.omneon.com/service-support

• ftp://ftp.omneon.com/Updates/Omneon/Current/

For support in Asia Pacific (other territories):

• Telephone: +65 6671 1499

• Fax: +65 6671 1454

• Email: apacsupport@omneon.com

• http://www.omneon.com/service-support

• ftp://ftp.omneon.com/Updates/Omneon/Current/

Company Address

Harmonic Inc.
4300 North First Street
San Jose, CA 95134  U.S.A.
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CHAPTER 2
Installing ProDrive
In this Chapter

• System Requirements

• System Compatibility

• What Gets Installed

• Installing ProDrive

• About ProDrive Licensing

• About the Omneon Media API DLL and ProDrive

System Requirements

Prior to installing ProDrive, your PC must conform to the following minimum requirements, and 
must be connected via Ethernet to your facility’s LAN:

• 2.4 GHz Pentium 4 or equivalent CPU

• 256 megabytes (MB) of RAM

• 1 gigabyte (GB) hard drive, or the minimum required for your operating system

• At least 30 megabytes of free disk space

• Windows XP, or Windows Vista ®

• Display resolution should be set to 1024 x 768 minimum

• Network access to a media server and SystemManager PC

• A Sony RS 422-compatible VTR with at least 1 serial com port (for the VTR Ingest feature only)

Cable Requirement for VTR Ingest

A VTR control cable is required to connect a VTR to MediaPorts associated with Players controlled 
by ProDrive. Omneon has qualified and validated the USB to RS-422 control cable available from 
Addenda Electronics for use with ProDrive. You can purchase the RS-USB/4 product directly from 
http://www.addenda.com/addenda-elect/products/rsUSB4.php or from other retailers.
ProDrive™ Release 1.2 11
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System Compatibility

ProDrive is compatible with Omneon Spectrum™ System software version 5.4 or later.

What Gets Installed

The application consists of a ProDrive installer, packaged in a .zip file. The .zip file also include a PDF 
of this guide. 

Installing ProDrive

To install:

1. Log on to the computer on which you want to install ProDrive. 

NOTE: During the installation process, an Omneon\ProDrive directory is created in the user’s Application 
Data directory. You will need read and write permissions to this directory to complete the installation.

2. If you have not already done so, open the ProDrive.zip folder that you downloaded from the 
Omneon support Web site and extract the files using the password provided by Technical Support. 
Contact Technical Support for assistance.

3. Locate the ProDrive-installer.exe file icon.

4. Double-click the ProDrive-installer.exe icon to begin the installation.

5. Click Yes to continue.
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6. Click Next and then follow the installation steps to install ProDrive. 

7. Click the agreement radio button and then Next.

8. Click Next to select the default destination location. By default, the application is installed to:
C:\Program Files\Omneon\Prodrive for Windows XP
C:\Program Files(x86)\Omneon\Prodrive for Windows 7
Omneon, Now Part of Harmonic 13
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9. Click Next to create the shortcut key.

10. Click Finish when installation is complete.

About ProDrive Licensing

When ProDrive is first installed, it will operate as an “Evaluation Copy”. The evaluation copy allows 
you to view some of the screens and dialogs of the software. You must, however, install a license to be 
able to ingest, edit, or playout media clips.

If you wish to launch ProDrive for evaluation purposes and do not yet have a valid license, do the 
following:
14 Installation and User’s Guide
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1. Launch the ProDrive application. You may encounter three different messages if you don’t have the 
correct configuration. Click OK in these message boxes and contact Harmonic for help:

1. If you don’t have a valid license, you will see: 

2. If the Advantech driver is not installed, ProDrive will report an error upon start up. Either install 
the driver if GPI control is required, or, click the Don't show this message again message 
checkbox in the dialog window.

3. If the commedia.dll file cannot be located, you will see:

2. Click OK. The ProDrive Configuration window appears as shown below.
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Note: The GPI Device box displays when your computer is connected to a GPI Device.

If this is a new installation, the Not Connected message displays in the bottom right hand corner of 
the Overview screen. This occurs because the application cannot access the prodrive.cfg file, since it 
does not yet exist. Enter the Samba IP address of the Spectrum server and define the root directory, 
and then click OK to create the prodrive.cfg configuration file and to proceed with your evaluation.
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Obtaining a Valid License

ProDrive requires a valid license to operate the application. Typically, Omneon emails you a license file 
upon receipt of your order. If you experience difficulties obtaining the license file, contact Omneon 
Technical Support. Once you obtain the file, place it in the same directory as your copy of ProDrive. 
For example: C:\Program Files\Omneon\ProDrive. Ensure the license file ends in .lice and 
not .lic. For example: ProDrive_license.lice. When you install a ProDrive license, the 
software will operate fully. 

To determine if your version is correctly licensed, launch ProDrive and select Help > About from the 
Menu bar. The About box displays information about each license installed, together with their 
expiration dates 

About the Omneon Media API DLL and ProDrive

A copy of the Omneon Media API DLL (ommedia.DLL) is required to enable the Save As and 
Flatten features available in the ProDrive application. This DLL is not packaged in the ProDrive 
executable. If you do not have a copy of this DLL, the following error message appears when you 
attempt to log on to the application.

To obtain a copy of the DLL, compatible with the Spectrum software version running on your system, 
contact Omneon Technical Support. Once you receive the file, save it to the location where 
ProDrive.exe is installed. The default location in Windows XP is C:\Program 
Files\Omneon\ProDrive. For Windows 7 it is C:\Program Files(x86)\Omneon\ProDrive.
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CHAPTER 3
Configuring ProDrive
In this Chapter

• Starting ProDrive

• Configuring a Media Server

• Limiting Access to the ProDrive Configuration Screens

• Customizing the Appearance of Events

• Assigning Roles to Players

• Disabling a Player for Use With ProDrive

• About Configuration and Log Files
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Starting ProDrive

To start:

1. Click Start > Programs > Omneon > ProDrive.

The Overview window opens.

NOTE: A Not Connected message appears in the bottom right corner of the window if ProDrive has not yet 
been configured. Proceed to Configuring a Media Server for instruction on how to configure the application.

NOTE: Running multiple instances of ProDrive on the same PC is not supported.

Configuring a Media Server

Ensure the following is completed before configuring a media server for control by ProDrive:

• All Players and media servers must have valid reference. VITC is mandatory if your are running 
either playout or scheduled ingest, AND you have selected VITC reference as the time 
synchronization source for that Player role. During a crash record, having VITC (or any reference) 
available is not a requirement but it is recommended. 

• All Players to be used by ProDrive must:

• Be activated and their control set to Manual, VDCP or BVW. Refer to “Player Configuration” 
in the Omneon SystemManager User’s Guide for step-by-step information.

• Have “Last Frame Freeze” set to 0.

• “Clock Ref ” VITC line values from within a media server configuration must be set correctly for 
your system.

• The “Time Zone” value from within a media server configuration must be set correctly for your 
system.

NOTE: Simultaneous control of Players using ProDrive and other controlling devices such as a DNF box is 
not recommended. A DNF box is not capable of controlling a ProDrive Playlist.
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To configure the media server IP address:

1. From the Omneon ProDrive menu bar, click Tools > Configuration.

The ProDrive Configuration window opens to the General tab.

NOTE: Configuration window opens automatically if no file system/media director has been specified.
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MediaDirector IP (Control) Specifies the current name, DNS name, or IP address of the 
Omneon server hosts.

File System Folders:

Root Folder Shows the default folder where the source clips reside. This 
value defines the default path to which Clip Management will 
open. You cannot access areas of the file system that fall outside 
of the specified root folder. For example, if this is set to 
/fs0/clip.dir then you will only be able to browse to folders 
under /fs0/clip.dir, you will not be able to browse /fs0/xyz.

Default Folder Specifies the path used during the first time the clip list is 
browsed. This value is used by The Clip Management screen and 
the Playout - Add Clips window.
The value defined in the Capture to Folder is the default browse 
path for Clip Prep, Scheduled Ingest, and VTR Ingest. This can 
be set per player in the player specific tab.
For all of the above scenarios, the last browsed to location is 
remembered for future access until the application is restarted. 
Once restarted, the defaults will once again be used. 

Timecode Display Specifies the timecode to display in ProDrive. The options are:
Timecode—cause all time-related fields and readouts in the 
application to display the internal timecode of a clip. The top left 
time is “elapsed time” from SOM, shown as a “time count” 
rather than a timecode. The top right is remaining time (time 
count) until EOM. The center or main time is the real 
“Timecode”. 
Frame Counts—causes all time-related fields and readouts in 
the application to display frame counts. The top left and right 
time become frame counts to/from EOM/SOM. The center or 
main time becomes frame count from the beginning of the 
physical clip.
Time Counts—causes all time-related fields and readouts in the 
application to display a relative time count in which the starting 
point of a clip is always zero. The top left time is “elapsed time” 
from SOM, shown as a “time count”. The top right is remaining 
time (time count) until EOM. The center or main time is the 
time count from the beginning of the physical clip (not the 
SOM).
Dropframe—if enabled, controls the display of 29.97 or 59.94 
timecodes when a Player is not involved, for instance in the 
display of clip durations in the media management screen. If a 
Player is involved (ie, when recording, or in a playout screen) 
then the drop-frame setting of the Player (from SystemManager) 
takes precedence. This should always be set to match that of the 
Player in SystemManager
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2. Click the Add button to the right of the Control IP Addresses box and enter the current name, DNS 
name, or IP address of the media server host. 

Tip: Omneon recommends using the IP address of the media server instead of the DNS name.

3. Click OK. 

To check a media server host’s current name, click the Configuration tab in the SystemManager 
application. The name appears beside the small media server icon.

NOTE: Your system can have multiple MediaDirectors but they must all use the same filesystem. ProDrive 
must be associated with a media server host before it can be linked to a Player on that host.

If the connection is successful, new tabs are added to the ProDrive Configuration window for each 
Player configured on that media server.

NOTE: The number of Players you can control is limited by your ProDrive license. The maximum number of 
Players is six.

4. Replace the Samba IP Address with the IP address of your file system. 

NOTE: Each ProDrive installation can talk to only one filesystem at a time.

Ingest Options See step # 6.
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5. Specify the File System Root folder, Default Folder, and Timecode Display, as required.

NOTE: The File System Root Folder is generally fs0 and is case sensitive. This value defines the default 
path to which Clip Management will open. You can find this value on the Disk Utilities screen in the 
SystemManager application. 

Tip: Whenever you need to enter a  folder name, use the "..." button to open a dialog to browse to available 
folders. This avoids problems with directory case-sensitivity.

6. Specify the Ingest Options including Suffix Separator, Clip Name Pattern, and Default Record 
Duration. 

7. Click OK.

Ingest Options Shows the following ingest options:
• Suffix Separator—When ProDrive creates new media clips, 

it may append a number to clip names to distinguish multiple 
attempts to create the clip. Use this option to separate a num-
ber appended by ProDrive from the parent clip name. For 
example, if you try to ingest MYCLIP several times with a 
suffix of "-", then files MYCLIP, MYCLIP-1, MYCLIP-2 will 
be created. 

Note: For clip names which end in a number, a new media 
clip will get a name which increments the last number of the 
parent clip; the clips will not have suffix separators. For 
example, if you try to ingest SPORT1 several times, files 
SPORT2, SPORT3, SPORT 4 etc will be created, assuming 
that SPORT2, SPORT3, and SPORT4 do not already exist. 

• Clip Name Pattern—Use for crash record only. The default 
pattern is $P_$D_$T_1, where $P is the current Player name, 
$D is the current date (dd-mmm-yy), and $T is the current 
time (hhmmss). Edit this pattern, if required, using any com-
bination of Unicode characters. Refer to About the Auto-
matic Renaming of Sub Clips Using Clip Patterns for 
additional information.

• Default record duration—shows the default record dura-
tion for all crash record events across all channels in the for-
mat hh:mm:ss:ff. 

GPI Device • Supports the Advantech 4751L 50pin to USB external device 
(P/N: USB-4751L-AE, http://www.advan-
tech.com/products/USB-4751L/mod_ABF6F937-9C73-
4198-B3ED-D97A611482C8:aspx. 

For more information see GPI Triggers.
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Limiting Access to the ProDrive Configuration Screens

ProDrive Configuration screens are, by default, openly accessible and configurable by any user of the 
ProDrive application. However, password protection can be applied to the ProDrive Configuration 
screens using the Windows Registry Editor. Once a password is set, users who attempt to access the 
Configuration screen will be prompted to enter a password before gaining access.

To set a password:

1. Ensure you have installed ProDrive version 1.1 or later. 

2. In Windows, click on Start > Run.

3. Enter regedit in the text field.

4. Click OK.

The Registry Editor window opens.

5. Navigate to:

My Computer > HKEY_LOCAL_MACHINE >SOFTWARE > Omneon > ProDrive > 
Config (for Windows XP)

Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > Omneon > 
ProDrive > Config (for Windows 7)

6. In the right hand panel, right click and select New > String Value.

7. Type Password and then press Enter.
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8. Double click Password. 

An Edit String dialog opens.

9. In the Value data: enter a password of your choice.

10. Click OK.

11. Close the Registry Editor

To verify or edit an existing password:

1. Open a Registry Editor Window.

2. Navigate to:

My Computer > HKEY_LOCAL_MACHINE >SOFTWARE > Omneon > ProDrive > 
Config (for Windows XP)

Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > Omneon > 
ProDrive > Config (for Windows 7)

3. In the right hand panel, view the existing password in the data column as shown below. 

Edit the password by double-clicking password and revising the text in the Value data field as shown 
below.
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4. Click OK. to save any changes.

To check if a password has been set:

1. Open a Registry Editor Window.

2. Navigate to:

My Computer > HKEY_LOCAL_MACHINE >SOFTWARE > Omneon > ProDrive > 
Config (for Windows XP)

Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > Omneon > 
ProDrive > Config (for Windows 7)

If a password has been set, it appears in the data column of the right hand panel. If a password is not 
set, the data column for password is blank as shown below.

Customizing the Appearance of Events

ProDrive assigns default colors to event status, types, and durations so these parameters can be easily 
distinguished in the ProDrive interface. If desired, you can assign your own color preferences to these 
Events.

To customize:

1. From the Omneon ProDrive menu bar, click Tools > Configuration.

The ProDrive Configuration window opens.

2. Click the Appearance tab.
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Table 5.  ProDrive Configuration—Appearance Tab 

Event Status Current (VTR 
Ingest)

The clip which is currently being ingested from tape to server. 

Cued (Playlist) The clip or file specified is cued for playout.

Ready The clip has been loaded onto the media server timeline.

Waiting The clip or file is hard-timed but has not yet reached its start 
time.

Playing The clip or file specified is currently playing out

Invalid The clip or file specified is invalid or missing. 

Pending The clip or file is scheduled to play, but is not yet playing and 
not yet pre-loaded for playing.

Disabled The Event specified has been disabled for use.

Completed The clip or file specified has successfully finished playing out or 
ingesting. 

Completed - 
Error

The clip or file specified has finished playing with errors.
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3. Choose the Event Status, Event Types, or Event Duration you want to change.

4. Click the Paint icon: .

5. Select the color you want to assign.

6. Click OK.

7. When you are done assigning colors to Events, click OK.

Assigning Roles to Players

ProDrive can control Players that have been configured in the Omneon System Manager application. 
Each Player can be configured in ProDrive to function in one of the following roles:

• None—Disables the Player for use by ProDrive. 

• Playout—Enables the Player for automated clip playout. See Playing Out Clips for more 
information.

• VTR Ingest—Enables the Player for VTR Ingest operations from VTRs. See Performing a 
VTR Ingest for more information.

• Scheduled Ingest—Enables the Player for scheduling ingests at specified times and dates. See 
Performing a Scheduled Ingest for more information.

• Clip Preparation—Enables the Player for previewing and editing of media clips. See Preparing 
Clips for more information.

Event Types Manual Events The clip or file specified will be started manually.

Auto Events The clip or file specified will start .

Hard-timed 
Events

The clip or file specified will start at the specified time.

Event 
Duration

Truncated Events The clip or file specified has been truncated by a following 
hard-timed event. 

Table 5.  ProDrive Configuration—Appearance Tab (Continued)
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ProDrive is available in one to six channel versions. The six channel version enables any combination 
of in/out ports that the hardware supports.

Disabling a Player for Use With ProDrive

To disable:

1. From the Omneon ProDrive menu bar, click Tools > Configuration.

The ProDrive Configuration window opens.

2. In the toolbar, click a Player tab.

3. Select the None option.

4. Click OK.

Table 6.  ProDrive Configuration—Player Tab 

Role Selects the role assigned to the Player. Refer to Assigning Roles to Players.

None Disables the Player for use by ProDrive.

Name

(Optional) Assigns a name to the button that appears in the Overview 
Window, as well as the button that appears in the top row of buttons. The 
default name is the one configured using SystemManager.

Channel Logo

(Optional) Assigns a logo (in png. format) to the button that represents this 
Player. The logo appears in the Overview window as well as the top row of 
buttons. Click Load Logo to use a logo; click Clear Logo to remove it. Note 
that all images are  resized to 48 x 48 pixels. Supported file types include .bmp, 
.jpg, .tif, and .png.
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About Configuration and Log Files 

Once you configure the ProDrive software, the application creates a configuration file (prodrive.cfg) 
and a directory for each configured Player/channel. This file, and all log files for the application, 
resides in the user’s Application Data Directory. 

If ProDrive was installed by the user “Administrator” then the following path is created and used by 
the executable: C:\Documents and Settings\Administrator\Application Data\Omneon\ProDrive

NOTE: Folder locations are specific to the operating system and language in use. In Windows Vista®, for 
example, the typical folder used is C:\Users\<username>\AppData\Roaming\Omneon\ProDrive.

If a different user, such as “Joe” then logged on to the same PC and launched ProDrive, the version of 
ProDrive that opens will not be configured for any MediaDirectors or Players. This is normal 
behavior since the application was looking for a configuration file in C:\Documents and 
Settings\Joe\Application Data\Omneon\ProDrive

Tip: Since the configuration file is not shared, each user must configure their own system. Omneon 
recommends you login to the PC as an administrator, install and configure the application, and then copy the 
prodrive.cfg file to each users Application Data\Omneon\Prodrive directory.
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CHAPTER 4
Performing a VTR Ingest
In this Chapter

• Overview

• Enabling a Player for VTR Ingest

• Configuring a COM Port for VTR Control

• Understanding the VTR Ingest Window

• Understanding the VTR Ingest List

• Managing VTR Ingest Lists

• Managing Clips in VTR Ingest Lists

• Managing a VTR Ingest

Overview

VTR Ingest capabilities allow you to capture content from your tapes while simultaneously controlling 
the source VTR via serial protocol. In addition, you can create an ingest list based on the content of a 
tape, and then  capture and digitize all marked sections from that tape. This feature captures content 
from multi-segment tapes, and also handles long-form content that spans multiple tapes. Ingest lists 
can also be created in external applications and imported into ProDrive.

Enabling a Player for VTR Ingest

Before enabling a Player for VTR Ingest, do the following:

• Using SystemManager, ensure the Player is configured for Play and Record, or Record.

• Connect a serial com port on the PC where ProDrive is installed to an RS-422 remote control 
port on a VTR. Refer to Cable Requirement for VTR Ingest for information about obtaining 
the recommeded cable. 

• Make sure the VTR and MediaPort have matching reference black.

• Connect the SDI out of the VTR to the SDI in on the MediaPort. 
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To enable:

1. From the Omneon ProDrive menu bar, click Tools > Configuration.

The ProDrive Configuration window opens.

2. In the Configuration window, click the desired Player’s tab.

3. Select the VTR Ingest option.

Table 7.  ProDrive Configuration—Player Tab 

Role
VTR Ingest

Enables the Player for VTR Ingest operations from video tape 
recorders.

Name

(Optional) Assigns a name to a button that represents a Player in 
playout or ingest roles. The button appears in the Overview 
window. The default name is the one configured in Omneon 
SystemManager.

Channel Logo

(Optional) Assigns a logo to the button that represents this Player. 
The logo appears in the Overview window.. Click Load Logo to 
use a logo; click Clear Logo to remove it. Note that all images are  
resized to 48 x 48 pixels. Supported file types include .bmp, .jpg, .tif, 
and .png.

VTR Control
Serial Port

Choose the serial port through which ProDrive will control this 
VTR.

Tape Preroll Select the number of seconds for the tape to roll before the inpoint.
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4. Configure the parameters you want.

5. Click OK. 

Buttons appear in the ProDrive toolbar representing the Player you have configured for VTR Ingest.

Configuring a COM Port for VTR Control

ProDrive can be configured to control a single VTR for either a specific Player, or for general use, not 
tied to a specific channel. Follow these steps to do either:

1. Connect the VTR’s remote control cable to a COM port on the PC. 

NOTE: This can be a serial COM port, or the USB connection if you have a USB to Serial dongle.

2. Enable the remote button on the VTR.

3. Determine if the VTR is going to be a general use VTR, or used for the specific purpose of VTR 
ingest, for example the Player’s Role is configured for VTR Ingest.

For general use (not tied to a specific channel ): Go to Tools > VTR Control and select the 
COM port connected to the VTR. A VTR control panel opens.

For a Specific Player: Go to Tools > Configuration > Player Tab > VTR Control/Serial Port.

NOTE: Multiple VTRs connected to multiple COM ports are suppored; each can be assigned to a different 
Player, or for general use.

NOTE: The Tools/VTR Control function cannot be used to control a VTR already assigned to a ProDrive VTR 
Ingest channel.

Eject Tape

This option is checked by default. You can de-select this option to 
configure the system to not eject the tape after the last ingest 
completes.

Default folder for Ingest
Capture to folder

Specifies the folder where the ingested clips are captured. If no 
value is defined here, then the Default folder for Ingest value 
defined on the General Tab will be used.

Ingest with Handles

Select this parameter if you want to have the cut ingested with 
additional content before the inpoint and after the endpoint. The 
copy will still play from in point to out point, but adding handles 
lets you widen the clip duration at a later time.

Handle Duration (seconds) Specifies a value, in seconds, for the handle length.

Table 7.  ProDrive Configuration—Player Tab (Continued)
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Understanding the VTR Ingest Window

The VTR Ingest window is arranged into different groups of controls and displays. From top to 
bottom, these are the Players area, Clip Status area, Transport controls, Jog/Shuttle dial, Cue to 
Timecode controls, Clip Trim controls, and a VTR Ingest List panel that contains clips for ingest. A 
Button bar is provided on the left side of the window.

Controls

Transport 
Controls

Jog/Shuttle Dial

Cue to Timecode 
Controls

Clip Status Area

Clip Trim Controls

Button bar

VTR 
Ingest 
List 
Panel 
with 
Clips

Players Area

Table 8.  VTR Ingest—Controls 

Shows the name of the Player and current status 
of the ingest process: Idle, Cueing to, or [1/N] 
Ingesting.

Indicates the process is idle.

Indicates a normal operating condition.
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Indicates a Warning condition that requires user 
intervention. For example, in a Playlist, an item 
may be cued but the Take button needs to be 
clicked. In a VTR Ingest, the Warning may be 
issued when you need to change reels. 

Indicates an Error condition that requires user 
intervention. For example, in a Playlist, the clip 
for the next event may be missing. In a VTR 
Ingest, the Warning may be issued because an 
ingest failed to occur, or the ingest was invalid.

Shows the current timecode location of the clip 
HH:MM:SS:FF (hours:minutes:seconds:frames) 
during playout. Also shows the transport status 
of the VTR in the upper right corner. If this 
timecode is displayed, then you have successful 
communication with the VTR via the serial port.

NOTE: Note that this is VTR timecode and not 
server timecode. 

(Rewind) Plays the VTR in reverse.

(Stop) Stops the playback of the VTR.

Plays (pauses) the VTR.

Plays the VTR.

(Fast Forward) Plays the VTR forward at 2x.

Table 8.  VTR Ingest—Controls (Continued)
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Enables manual control of tape by moving the 
Jog/Shuttle dial as follows:

• moving the dial to the left changes the clip’s 
current speed to the next faster reverse 
speed.

• moving the dial to the right changes the 
clip’s current speed to the next faster for-
ward speed.

The following transport speeds are 
supported, as multiples of normal forward 
play: -32, -16, -8, -4, -2, -1, -1/2, -1/4, -1/16, 
-1/32, 0, 1/32, 1/16, 1/8, 1/4, 1/2, 1, 2, 4, 8, 
16, 32.

• moving the dial to the left or the right by 
one click jogs forward or backward, one 
frame at time.

• clicking and holding the dial for a couple of 
seconds switches between jog and shuttle 
mode.

Cues the VTR to the specified timecode. Enter 
the timecode values in the fields provided, then 
press the Cue button.

Modifies performance of Jog/Shuttle and JKL 
keys to use slower speeds for fine control. 
Shuttle control now runs at max +/- 2x speed.

• Mark [IN Point], Mark [OUT Point]—
These two buttons set the inpoint and out-
point of the material on the tape which you 
want ingested. Once ingested, the clip's 
SOM and EOM are set to match these 
frames. Clicking a Mark button sets that 
point on the VTR’s current frame. Both the 
inpoint and outpoint are inclusive; the frames 
thus marked are the first and last frames to 
be shown during clip playback.

• Cue [IN Point], Cue [OUT Point]—
These two buttons cue to the in point or 
outpoint of the VTR/tape.

• Clear [IN Point], Clear [OUT Point]—
Clicking a Clear button clears the corre-
sponding marked point.

Duration — Shows the duration of the tape 
segment between the inpoint (SOM) and 
outpoint (EOM).

Table 8.  VTR Ingest—Controls (Continued)
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Buttons

Menus

Table 9.  VTR Ingest—Buttons 

Clears the current VTR Ingest list from the VTR Ingest List panel.

Opens an existing VTR Ingest list in the VTR Ingest List panel.

Saves the current batch list using the default name batchlist.ale.

Saves the current VTR Ingest list to a directory and name of your choice.

Runs the VTR Ingest list currently loaded in the VTR Ingest List panel.

Resets the VTR Ingest list to the beginning.

Puts the MediaPort in record mode and begins recording whatever signal is 
currently going to the SDI IN of that port. The port used is the same as the 
port configured for this role; in this case, VTR ingest. Crash records can be 
configured to run  for a specified duration, creating a clip on your media 
server, and clips can be scheduled for playout on another port while being 
recorded. 

Table 10.  VTR Ingest—Menus

File • Exit—closes ProDrive and exits the application.

Tools • Configuration—configures ProDrive.
• VTR Control—opens a VTR transport control window for VTRs connected 

to the PC serial com port(s).
• View Log—displays the event log at the bottom of the window.

Help • About—provides information about the ProDrive release.
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Understanding the VTR Ingest List

A VTR Ingest list is based on the content of a tape and contains the following information:

• Heading

• Video format

• FPS

• Tape number

• Start time

• End time

• Duration

• Track number

• Name

VTR Ingest lists use the Avid Log Exchange (ALE) format. Lists can be created in ProDrive or in an 
external applications and imported into ProDrive. You can create them with a text editor and save 
them with a .ale extension.

The following illustration shows an example of a VTR Ingest list.

Managing VTR Ingest Lists

This section provides the following procedures:

• Creating VTR Ingest Lists

• Opening VTR Ingest Lists

• Clearing VTR Ingest Lists
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Creating VTR Ingest Lists

To create a VTR Ingest list:

1. From the Omneon ProDrive toolbar, click the Player configured for VTR Ingest.

2. Do the following:

a. On the Transport controls, click Play.

The tape begins to play.

b. Using a monitor, watch the tape and determine the inpoint and outpoint for this clip.

c. Using the In Point and Out Point controls, mark the inpoint and outpoint for this clip.

3. Repeat step 2 for each clip you want to add.

NOTE: You can use the Transport controls, Jog/Shuttle dial, and Cue to Timecode tools to locate the time or 
frame you want to mark in the clip.

4. On the Transport controls, click Stop.

5. When you are done, click Save Ingest List using a name and directory of your choice. Retain the .ale 
file extension.
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Opening VTR Ingest Lists

To open a VTR Ingest list:

1. From the Omneon ProDrive toolbar, click the Player configured for VTR Ingest.

2. In the VTR Ingest window button bar, click Open Ingest List.

The Open Ingest List File window opens.

3. Select the VTR Ingest list you want.

4. Click OK.

The VTR Ingest list is loaded in the VTR Ingest List panel.
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Clearing VTR Ingest Lists

To clear a VTR Ingest list:

1. From the Omneon ProDrive toolbar, click the Player configured for VTR Ingest.

2. In the VTR Ingest window button bar, click New Ingest List. A confirmation dialog appears. Click 
Yes to clear the Ingest List.
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Managing Clips in VTR Ingest Lists

This section provides the following procedures:

• Adding Clips to a VTR Ingest List

• Editing Clips in a VTR Ingest List

• Deleting Clips from a VTR Ingest List

• Cueing Clips in a VTR Ingest List

Adding Clips to a VTR Ingest List

To add clips to a VTR Ingest list:

1. From the Omneon ProDrive toolbar, click the Player configured for VTR Ingest.

2. Right-click the VTR Ingest List panel and select New Clip.
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The Add Event window opens.

3. In the Clip Name field, enter a name for the clip.

4. In the Folder field, browse to the folder where the clip will be saved.

5. In the Reel field, enter the reel number.

Use this field if the clip is part of a VTR Ingest list that spans multiple reels.

6. In the Capture section, enter the In Point and Out Point for the clip.

The duration is calculated for you.

7. Click OK.

The clip is added to the VTR Ingest List panel.

8. Repeat steps 1 through 7 for each clip you want to add to the VTR Ingest list.

9. When you are done, click Save Ingest List using a name and directory of your choice. Retain the .ale 
file extension.
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Editing Clips in a VTR Ingest List

To edit a clip in a VTR Ingest list:

1. From the Omneon ProDrive toolbar, click a Player configured for VTR Ingest.

2. Right-click the clip you want in the VTR Ingest List panel and select Edit Clip.

The Edit Event window opens.

3. In the Clip Name field, enter a name for the clip.

4. In the Folder field, browse to the folder where the clip will be saved.

5. In the Reel field, enter the reel number if the clip is part of a VTR Ingest list that spans multiple reels.

6. In the Capture section, enter the In Point and Out Point for the clip.

The duration is calculated for you.

7. Click OK.

8. When you are done, click Save Ingest List using a name and directory of your choice. Retain the .ale 
file extension.
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Deleting Clips from a VTR Ingest List

To delete a clip from a VTR Ingest list:

1. From the Omneon ProDrive toolbar, click a Player configured for VTR Ingest.

2. Right-click the clip you want in the VTR Ingest List panel and select Delete Clip or press Delete on 
your keyboard.

NOTE: No confirmation is required to delete a clip.

3. When you are done, click Save Ingest List using a name and directory of your choice. Retain the .ale 
file extension.
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Cueing Clips in a VTR Ingest List

The Cue Clip function cues the VTR to the current time in the selected clip.

To cue a clip in a VTR Ingest list:

1. From the Omneon ProDrive toolbar, click the Player configured for VTR Ingest.

2. Right-click the clip you want in the VTR Ingest List panel and select Cue Clip.

Managing a VTR Ingest

This section explains how to perform the following procedures:

• Running a VTR Ingest

• Skipping to the Next Clip

• Stopping a VTR Ingest
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Running a VTR Ingest

To run a VTR Ingest:

1. From the Omneon ProDrive toolbar, click a Player configured for VTR Ingest.

2. Create or open a VTR Ingest list. The VTR Ingest list is loaded in the VTR Ingest List panel 

3. In the VTR Ingest window button bar, click Run Ingest List. 

ProDrive begins the ingest process.

4. If multiple reels are required, the current reel is ejected and you will be prompted to insert the next 
reel in a multi-reel ingest.
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5. Insert the next tape and click OK.

6. To complete the VTR Ingest process, allow all clips to be ingested.

When the process is done, ProDrive will eject the tape in the VTR, and the status will return to Idle.

Skipping to the Next Clip

To skip to the next clip in a VTR Ingest:

1. From the VTR Ingest window, click Skip.

• If the ingest of the current clip has not yet begun, the current event will be skipped and the 
remaining items in the list will be ingested. 

• If the the ingest of the current clip has already begun, the ingest will stop, the partial clip will be 
deleted from the server, and the remaining items will be ingested.

Stopping a VTR Ingest

To stop a VTR Ingest:

• From the VTR Ingest window, click Abort.

The VTR Ingest process stops and the VTR status changes to Idle.
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Rerunning a VTR Ingest

To rerun a VTR Ingest:

1. From the VTR Ingest window, click Reset List. 

The list status clears, as if it had never run. 

2. Click Run Ingest

The ingest process begins. If the clip name is alrady present at the specified location on the server, it 
will not be reingested and the status will show invalid; the event will be skipped.

NOTE: To reingest material such as replacing a clip, go to Clip Management and delete the old clip first 
before rerunning the ingest.
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CHAPTER 5
Performing a Scheduled Ingest
ProDrive’s schedule management features enables users to view, edit, and create new scheduled record 
items at any time of day, for any duration. At the specified time, your media server will  switch to 
record mode and capture your desired content. 

The following topics are covered in this chapter:

• Understanding the Scheduled Ingest Window

• Enabling a Player For Scheduled Ingest

• Managing Scheduled Ingest Lists

• Managing Scheduled Ingest Events
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Understanding the Scheduled Ingest Window

The Scheduled Ingest window is arranged into different groups of controls and displays. From top to 
bottom, these are the Players Area and Clip Status Area. A Button bar is provided on the left side of 
the window. The Scheduled Ingest List panel is on the right.

Controls

Clip Status 
Area

Button Bar

Scheduled 
Ingest List 
Panel with 
Clips

Players 
Area

Schedule 
Grid with 
Events 
Highlighted

Free Space 
(hours)

Table 11.  Scheduled Ingest—Controls 

Shows the name of the Player and current status 
of the ingest process: Idle, Cueing to, or [1/N] 
Ingesting.

Indicates the process is idle.

Indicates a normal operating condition.

Indicates a Warning condition that requires user 
intervention. For example, in a Playlist, an item 
may be cued but the Take button needs to be 
clicked. In a VTR Ingest, the Warning may be 
issued when you need to change reels.
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Buttons

Menus

Indicates an Error condition that requires user 
intervention. For example, in a Playlist, the clip 
for the next event may be missing. In a VTR 
Ingest, the Warning may be issued because an 
ingest failed to occur, or the ingest was invalid.

Table 11.  Scheduled Ingest—Controls (Continued)

Table 12.  Scheduled Ingest—Buttons 

Clears the current scheduled ingest list from the Scheduled Ingest List panel.

Opens an existing scheduled ingest list in the Scheduled Ingest List panel.

Saves the current scheduled ingest list to a directory and name of your choice.

Puts the MediaPort in record mode and begins recording whatever signal is 
currently going to the SDI IN of that port. The port used is the same as the 
port configured for this role; in this case, Scheduled ingest. Crash records can 
be configured to run  for a specified duration, creating a clip on your media 
server.

Table 13.  Scheduled Ingest—Menus

File • New Schedule—clears the Scheduled Ingest panel enabling you to load a new 
ingest list.

• Open Schedule—opens a Scheduled Ingest List.
• Save Schedule—saves the current loaded Scheduled Ingest List using the 

name and directory of your choice.

Edit • New Event—creates a new event.
• Delete Event—deletes the selected event from the Playlist panel.
• Edit Event—edits the selected event.

Tools • Configuration—configures ProDrive.
• VTR Control—selects the COM through which ProDrive communicates 

with the VTR.
• View Log—displays the event log at the bottom of the window.

Help • About—provides information about the ProDrive release.
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Enabling a Player For Scheduled Ingest

To enable a Player for scheduled ingest:

1. From the Omneon ProDrive menu bar, click Tools > Configuration.

The ProDrive Configuration window opens.

2. In the Configuration window, click on the desired Player’s tab.

3. Select the Scheduled Ingest option. 

Table 14.  ProDrive Configuration—Player Tab 

Role
Scheduled Ingest

Enables the Player for scheduled ingest at specified times and 
dates.

Name

(Optional) Assigns a name to the button that appears in the 
Overview Window, as well as the button that appears in the top 
row of buttons. The default name is the one configured using 
SystemManager.

Channel Logo

(Optional) Assigns a logo to the button that represents this 
Player. The logo appears in the Overview window as well as the 
top row of buttons. Click Load Logo to use a logo; click Clear 
Logo to remove it. Note that all images are  resized to 48 x 48 
pixels. Supported file types include .bmp, .jpg, .tif, and .png.

Default folder for Ingest
Capture to folder

Specifies the folder where the ingested clips are captured. The 
default folder is defined in the general tab under Default folder 
for ingest.
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4. Configure the parameters you want.

5. Click OK.

Default folder for Ingest
Append Date

Adds the current date to the end of the specified clip name. The 
date is in the following format :
YYMMDY, i.e. clipname_091001. 
By checking this option, Append Date is always enabled from 
within the Scheduled Ingest screen. You can uncheck this option 
when a record event is created/scheduled.

Timecode/Time of Day
Time-of-day Source

Specifies the the time source used for issuing timed event 
commands such as playing or recording at a specific time of day.

• Local PC Time—uses the local time on the client PC as the 
time reference.

• Player LTC—uses the Linear timecode (LTC) of the Player 
as the time reference.

• Media Director Time—uses the media server time as the 
time reference.

• VITC Reference—uses SMPTE Vertical interval timecode 
(VITC) as the time reference. For frame accuracy, Omneon 
recommends using VITC Reference for Playout and Sched-
uled Ingest roles. Both the media server and MediaPort 
should be supplied reference from the same VITC reference 
source.

Segment Clips Specifies that the Segment Clip option for each scheduled ingest 
will be on by default.

Segment Duration Specifies the default segment length in hh:mm:ss:ff.. The 
maximum number of segments allowed per record event is 48. 
For example, if you have a 24 hour record event and you want it 
segmented, then you should not use a segment duration of less 
than 00:30:00:00. If you do, then the number of segments above 
48 will not be recorded. Similarly, if you have a 12 hour record 
event, the minimum segment duration would be 00:15:00:00.

Segment Duration:
Tag with Number

Sequentially, beginning with 1, appends a number to the Clip 
Name for each segment that is created. i.e. ingest_1, ingest_2, 
ingest_3.

Segment Duration:
Tag with Time

Appends the time of day the clip is created to the Clip Name for 
each segment that is created. i.e. ingest_221500, ingest_221700, 
ingest_221900.

Table 14.  ProDrive Configuration—Player Tab (Continued)
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Managing Scheduled Ingest Lists

This section provides the following procedures:

• Assigning a Scheduled Ingest List for a Player

• Clearing Scheduled Ingest Lists

• Saving Scheduled Ingest Lists

Assigning a Scheduled Ingest List for a Player

To assign a scheduled ingest list to a Player:

1. From the Omneon ProDrive Player’s Area, click the Player configured for scheduled ingest.

2. In the Scheduled Ingest window button bar, click Open Schedule. 

The Open window appears.
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3. Select the scheduled ingest list you want.

4. Click OK.

The scheduled ingest list is loaded in the Scheduled Ingest List panel.

Clearing Scheduled Ingest Lists

To clear a scheduled ingest list:

1. From the Omneon ProDrive Player’s Area, click the Player for which you want to clear the Scheduled 
Ingest List.

2. In the Scheduled Ingest window button bar, click New Schedule.

The Scheduled Ingest List is cleared in the Scheduled Ingest List panel.
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Saving Scheduled Ingest Lists

To save a scheduled ingest list:

1. From the Omneon ProDrive Player’s Area, click a Player configured for scheduled ingest..

2. Edit the list, as required.

See Editing Events in a Scheduled Ingest List for more information.

3. In the Scheduled Ingest window button bar, click Save Schedule.

Save the schedule using a name and directory of your choice.

Managing Scheduled Ingest Events

This section provides the following procedures:

• Adding Events to a Scheduled Ingest List

• Editing Events in a Scheduled Ingest List

• Deleting Events in a Scheduled Ingest List
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Adding Events to a Scheduled Ingest List

To add an event to a Scheduled Ingest list:

1. From the Omneon ProDrive Player Area, click the Player configured for scheduled ingest.

2. Right-click anywhere in the Scheduled Ingest List panel and select New Event. 

The Add Scheduled Event window opens.
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3. Configure the parameters you want.

4. Click OK.

The event is added to the Scheduled Ingest List panel.

NOTE: The schedule will reflect any currently active recording for the port that is configured for that instance 
of Scheduled Ingest. 

5. Repeat steps 1 through 4 for each ingest event you want added to the Ingest schedule.

6. When you are done, click Save Schedule using a name and directory of your choice. Retain the .txt 
file extension.

Table 15.  Add Scheduled Event 

Enabled Enables the event for ingest.

Clip Name Specifies the name of the clip being ingested.

Append Date Appends the date (YYMMDAY) the clip is created to the Clip 
Name defined above  i.e. ingest_090917, ingest_090919, 
ingest_090921. 

Folder Specifies the folder in which the clip will be ingested.

Description Provides a description of the ingest. Note that this description is 
not saved as part of the clip’s metadata. It is solely used in the 
ProDrive’s GUI.

Timing: Once, on Specifies the day and time of the ingest.

Timing: Every... Specifies the days and time at which the clip will be ingested. 
(You can choose one day or all days, but not some of the days)

Timing: Start at Specifies the start time in 24-hour format, HH:MM:SS:FF 
(hour:minutes:seconds:frames)

Timing: Duration Specifies the duration of the clip being ingested in 
HH:MM:SS:FF (hours:minutes:seconds:frames) for the ingest to 
begin..

Segment Clip Segments the clip according to the specified duration.
• Tag with number—Sequentially, beginning with 1, appends a 

number to the Clip Name defined above for each segment 
that is created. i.e. ingest_1, ingest_2, ingest_3.

• Tag with time—Appends the time of day the clip is created 
to the Clip Name defined above for each segment that is cre-
ated. i.e. ingest_221500, ingest_221700, ingest_221900.
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Editing Events in a Scheduled Ingest List

To edit an event in a scheduled ingest list:

1. From the Omneon ProDrive Player Area, click the Player for which you need to edit the Scheduled 
Ingest List.

2. Right-click the desired event in the Scheduled Ingest List panel and select Edit Event.

The Edit Scheduled Event window opens.

3. Configure the parameters you want.

See Adding Events to a Scheduled Ingest List for more information.

4. Click OK.
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Deleting Events in a Scheduled Ingest List

To delete an event in a scheduled ingest list:

1. From the Omneon ProDrive Player Area, click the Player configured for scheduled ingest.

2. Right-click the desired event in the Scheduled Ingest List panel and click Delete Event.

No confirmation is necessary.
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CHAPTER 6
Preparing Clips
In this Chapter

• Overview

• Understanding the Clip Preparation Window

• Enabling a Player for Clip Preparation

• Managing Clips and the Clip Prep List

Overview

ProDrive provides clip preparation tools for trimming the in and out points of existing clips, creating 
new sub-clips from existing clips, and combining multiple clips into a single new clip (flattening), to 
ensure that the content stored on your media server is ready for transmission whenever you need it. 
Using ProDrive, you can load any available clip from your media server into any ProDrive configured 
Player and play, pause, rewind, fast forward, to review, edit, and update the Start of Media (SOM) and  
End of Media (EOM) of that clip.

You can jog and shuttle through the clip, find points of interest, mark new in and out points, and  
create new sub-clips based on this data or flatten individual clips into a new file. 

Understanding the Clip Preparation Window

The Clip Preparation window is arranged into different groups of controls and displays. From top to 
bottom, these are the Players Area, Clip Status Area, the Transport Controls, Shuttle Controls, 
Looping Controls, Cue to Timecode Controls, and the Clip Trim Controls. A Button bar is provided 
on the left side of the window. A Clip Prep List panel appears on the right.
ProDrive™ Release 1.2 65



  Preparing Clips
Controls

Transport 
Controls

Jog/Shuttle Dial

Looping, 
Bounce, and 

Timecode 
Controls 

Clip Status Area

Clip Trim 
Controls

Button bar

Clip Prep 
List Panel 
with Clips

Players Area

Table 16.  Clip Preparation—Controls 

Shows the name of the clip.

Indicates the process is idle.

Indicates a normal operating condition.

Indicates a Warning condition that requires 
intervention. For example, in a Playlist, an item 
may be cued but the Take button needs to be 
clicked. In a VTR Ingest, the Warning may be 
issued when you need to change reels. 

Indicates an Error condition that requires user 
intervention. For example, in a Playlist, the clip 
for the next event may be missing. In a VTR 
Ingest, the Warning may be issued because an 
ingest failed to occur, or the ingest was invalid.

Shows the status of the clip: Stop, Pause, 
Forward, Rewind, Pause, or Playing.
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Shows duration elapsed, as represented by the 
timecode and progress bar. This will be 
displayed as Time Count or Frame Count, 
depending on the setting used  in the General 
Configuration tab. If Frame Count is used, this 
will be displayed in frames, otherwise this is 
displayed as a Time counter..

Shows the duration remaining. This will be 
displayed as Time Count or Frame Count, 
depending on the setting used  in the General 
Configuration tab. If Frame Count is used, this 
will be displayed in frames, otherwise this is 
displayed as a Time counter..

Shows the current position of the clip in 
HH:MM:SS:FF (hours:minutes:seconds:frames). 
This will be displayed as Timecode, Time 
Count, or Frame Count depending on the 
setting  used in the General Configuration tab.

(Previous clip) Plays the previous clip. Note that 
Previous Clip/Page up typically moves to the 
head of the previous clip. If you are NOT at the 
head of the current clip however, this control 
will move you to the head of the current clip 
instead.

(Rewind) Plays the clip at –8x.

(Stop) Stops the playback or recording of a clip.

Plays (pauses) the clip at 0x, presenting a still 
frame. If no clip is loaded, black is played.

Plays the clip at 1x (normal play mode).

(Fast Forward) Plays the clip at 8x.

(Next clip) Plays the next clip. Note that Next 
Clip/Page down always moves you to the head 
of next clip - unless you are already at the last 
clip, in which case, it moves you to the tail of the 
last clip.

When on, limits speed to +/- 2x .

Table 16.  Clip Preparation—Controls (Continued)
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Controls the jog/shuttle dial as follows:
• moving the dial to the left changes the clip’s 

current speed to the next faster reverse 
speed.

• moving the dial to the right changes the 
clip’s current speed to the next faster for-
ward speed.

The following transport speeds are 
supported, as multiples of normal forward 
play: -32, -16, -8, -4, -2, -1, -1/2, -1/4, -1/16, 
-1/32, 0, 1/32, 1/16, 1/8, 1/4, 1/2, 1, 2, 4, 8, 
16, 32.

• moving the dial to the left or the right by 
one click jogs forward or backward, one 
frame at time.

Tracks and enables manual control of the shuttle 
process. Press and hold to switch between jog 
and shuttle modes, as for VTR ingest. 

Specifies the following looping options:
• None—Disables looping and bounce.
• Loop—Causes the clip list, which can be 

comprised of a single clip, or multiple clips 
loaded in the Clip Prep list area, to restart 
upon reaching its end. In this mode, the clip 
plays continuously until Stop is clicked. 
Inactive clips (not shown in red) can be 
selected and moved while the Player is in 
Loop mode. Note that the Player must be 
stopped before the Loop mode can be acti-
vated.

• Bounce— Repeatedly plays a clip from its 
IN point and OUT point and then back 
again. In this mode, the clip reverses when it 
reaches its OUT point, playing back and 
forth. NOTE: Bounce mode works only 
with DV clips. It does not work with MPEG 
I-frame or Long GOP clips.

NOTE: Looping and Bounce are only applicable 
when the clip is being controlled through Clip 
Preparation. 

Cues the clip to the specified timecode. Enter 
the timecode values in the fields provided.

Table 16.  Clip Preparation—Controls (Continued)
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Buttons

• Mark [IN Point], Mark [OUT Point]—
These two buttons set the clip’s inpoint and 
outpoint — the starting and ending frames 
for clip playback. Clicking a Mark button 
sets that point on the clip’s current frame. 
Both the inpoint and outpoint are inclusive; 
the frames thus marked are the first and last 
frames to be shown during clip playback.

• Cue [IN Point], Cue [OUT Point]—
These two buttons cue to the in point or 
outpoint of the clip.

• Clear [IN Point], Clear [OUT Point]—
Clicking a Clear button clears the corre-
sponding marked point.

Duration — Shows the duration of the clip 
between the inpoint (SOM) and outpoint 
(EOM).

NOTES: 

• When no inpoint is set, the default inpoint is 
the first frame of the clip and the corre-
sponding Clear button is grayed-out and 
disabled.

• When no outpoint is set, the default out-
point is the last frame of the clip and the 
corresponding Clear button is grayed-out 
and disabled.

Table 16.  Clip Preparation—Controls (Continued)

Table 17.  Clip Preparation—Buttons 

Loads a clip from the selected director to the Clip Prep List. You can now 
manage the clip with ProDrive using the Transport controls and perform clip 
editing procedures using the Looping, Cue to Timecode, and Clip Trim 
controls.

Adds a clip from the selected directory to the Clip Prep List panel.

Saves a new clip in the defined directory with the file name you specify. Clips 
must be I-Frame only and have the exact same attributes including: number 
and type of video tracks, number and type of audio tracks, format, and frame 
rate. LGOP clips are not distinguished from I-Frame. 
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Clears the Clip Prep List panel.

Updates the selected clip with the changes you made.

Flattens the selected clips into a new clip with the file name you specify. Clips 
to be flattened together must be I-Frame only and have the exact same 
attributes including: number and type of video tracks, number and type of 
audio tracks, format, and frame rate. LGOP clips are not distinguished from I-
Frame but will not flatten correctly. 

NOTE: Save As and Flatten are very similar. Flatten performs a Save As, then 
loads the newly created clip onto the timeline, replacing the existing timeline 
contents.

Allows you to begin an ingest using the currently selected Player. Crash 
records will run for the specified duration, creating a clip on your media 
server, and clips can be scheduled for playout on another port while being 
recorded. 

Table 17.  Clip Preparation—Buttons (Continued)
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Menus

Table 18.  Clip Preparation—Menus

File • Exit—closes ProDrive and exits the application.

Clip 
Preparation

• Load Clip—loads a clip from the selected directory to the Clip Prep List. 
• Add Clip—adds a clip from the selected directory to the Clip Prep List panel.
• Save As—saves a new clip in the defined directory with the file name you 

specify. The default name presented for sub clips depends on the name of the 
parent clip. If the parent clip has a datetime at the end, then the default name 
is the parent name with an updated datetime. If the parent clip has a sequence 
number, then the next free number in sequence is used. If the parent clip has 
neither, then a sequence number is added using the suffix separator config-
ured as part of the ingest options in the Configuration General tab.

Note: The datetime appended to the end of a clip name is the time at which the 
Save As dialog box was opened. Close the dialog box and reopen the box to 
ensure the current date and time is appended to the clip name. 

• Update—updates the selected clip or clips with the changes you made.
• Load Latest Recording—loads the most recent Crash Record clips from the 

current session known by ProDrive. VTR, scheduled ingest clips, or clips 
ingested from another session, or via a different application will not be 
loaded.

Tools • Configuration—configures ProDrive.
• VTR Control—opens a VTR transport control window for VTRs connected 

to the PC serial com port(s).
• View Log—displays the event log at the bottom of the window.

Help • About—provides information about the installed ProDrive release.
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Enabling a Player for Clip Preparation

To get started:

1. From the Omneon ProDrive menu bar, click Tools > Configuration.. The ProDrive Configuration 
window opens.

2. Select the tab for the desired Player.

3. Select the Clip Preparation option.

4. Configure the parameters you want.

5. Click OK.

Table 19.  ProDrive Configuration—Player Tab 

Role
Clip Preparation

Enables the Player for the manual previewing, preparation, and 
editing of media clips.

Name

(Optional) Assigns a name to the button that appears in the 
Overview Window, as well as the button that appears in the top row 
of buttons. The default name is the one configured using 
SystemManager.

Channel Logo

(Optional) Assigns a logo to the button that represents this Player. 
The logo appears in the Overview window as well as the top row of 
buttons. Click Load Logo to use a logo; click Clear Logo to 
remove it. Note that all images are  resized to 48 x 48 pixels. 
Supported file types include .bmp, .jpg, .tif, and .png.

Default Folder for ingest
Capture to folder

Specifies the folder where the ingested clips are captured when a 
Crash Record is performed, or when new content is created from 
either flattening or creating new sub-clips.
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Managing Clips and the Clip Prep List

This section describes the following tasks:

• About Opening Clips

• Adding Clips to the Clip Prep List

• Updating Clips

• Loading Clips

• Creating New Clips

• Flattening Clips

• Recording Clips (Crash Record)

• Ejecting Clips

• Clearing Clips

About Opening Clips

Right clicking on a clip allows you to view the clip “Open” option. When you click “Open”, the clip 
opens with the application assigned for that file extension in Windows. For example, if you have 
QuickTime installed, “.mov” clips will open in QuickTime Viewer.. VLC MediaPlayer 
(http://www.videolan.org/vlc) can open .MXF files with embedded essence. If “Open” is greyed out, 
no application has been assigned to open the file extension of the particular clip.

Adding Clips to the Clip Prep List

To add a clip:

1. From the Omneon ProDrive Player Area, select the Player you have configured for Clip Preparation.

2. From the Omneon ProDrive menu bar, click Clip Preparation > Add Clip.

The Clip Management window opens.
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3. Select the clip you want to add.

NOTE: You can select multiple clips using the Ctrl or Shift key.

4. Click OK.

The selected clips appear in the Clip Preparation window.

5. Repeat Step 2 through Step 4 for each clip you want to add.

Tip: You can reorder clips in the Clip Preparation List panel by dragging and dropping them to a new location 
in the list.

Updating Clips

Updating a clip involves changing its inpoint, outpoint, or both and then saving the updates/changes. 

To update a clip:

1. From the Omneon ProDrive Player Area, select a Player you have configured for Clip Preparation.

2. From the Clip Preparation List panel, select the clip you want to update.

3. Using the Clip Trim Controls, mark the new IN Point and OUT Point.

4. In the Clip Preparation window button bar, click Update Clip.

A window opens with details of the updates.

Loading Clips

To load a clip:

1. From the Omneon ProDrive Player Area, select a Player you have configured for Clip Preparation.

2. In the Clip Preparation window button bar, click Load Clip.
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The Clip Management window opens.

3. Select the clip you want.

4. Click OK.

The clip appears in the Clip Preparation window and is loaded in the Player. You can now manage the 
clip with ProDrive using the Transport controls and perform clip editing procedures using theCue to 
Timecode, and Clip Trim controls.

Creating New Clips

To create a new clip from an existing clip:

1. From the Omneon ProDrive Player Area, select the Player you have configured for Clip Preparation.

2. From the Clip Preparation List panel, select the clip you want to duplicate.

3. In the Clip Preparation window button bar, click Save As.

The Clip Management window opens.
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4. In the File Name field, enter the new name for the new clip.

5. Click OK. 

Now you can edit the duplicate clip and make changes to the media without affecting the original clip.

Flattening Clips

Flattening clips involves merging multiple clips in the order in which they appear in the Clip 
Preparation window into a single clip.

To flatten clips into one clip:

1. From the Omneon ProDrive Player Area, select a Player you have configured for Clip Preparation.

2. In the Clip Preparation window button bar, click Load or Add Clip.

The Clip Management window opens.

3. Select the clips you want to flatten.

4. Click OK.

The clips appear in the Clip Preparation window.
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5. (Optional) Using the Clip Trim Controls, mark the new IN Point and OUT Point for each clip.

6. In the Clip Prep window button bar, click Flatten.

The Clip List window opens.

7. In the File Name field, enter the name for the flattened clips.

8. Click OK.

The flattened clip replaces the previous clips in the Clip Prep list panel.

NOTES: Flattening of clips only works frame accurately for I-Frame content. Clips to be flattened should be 
of the same format and wrapper type.

Recording Clips (Crash Record)

A Crash Record allows you to record a clip without having to name the clip or set up its recording 
duration. This type of recording is beneficial when a quick recording is required.

To crash record a clip:

1. From the Omneon ProDrive Player Area, select a Player you have configured for Clip Preparation.

2. In the Clip Preparation window button bar, click Crash Record.
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The Crash Record window opens.

3. (Optional) Specify a new Clip Name for the clip.

NOTE: If no name is specified, the system will auto assign a name. The system will assign a name based on 
the default clip name pattern as specified in the Configuration > General Tab > Ingest Options.

4. (Optional) Specify a new Destination Folder for the clip.

NOTE: The default path, as defined in the Configuration window, will appear in gray.

5. (Optional) Specify the Duration for the clip to run.

NOTE: The system will assign a duration based on the Default clip duration as specified in the 
Configuration > General Tab > Ingest Options.

6. To start a crash record, do the following:

a. Click Record.

Content that is currently being fed to the ingest port is recorded and created on the media server.

NOTE: While the clip is being recorded on the ingest port, you can schedule other clips for playout on a 
playout port.

b. To cancel and discard the crash record, click Cancel.

c. To stop and save the crash record, click Stop.
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NOTE: While the crash record dialog is open, it is not possible to access other areas of ProDrive. To access 
other areas of ProDrive click on the X in the upper right corner of the Crash Record dialog window. This 
closes the window without stopping the record. The record will continue in the background until the specified 
duration has been reached. 

NOTE: Clicking on Crash Record from within the Clip Prep window displays the current status of any ingest 
that port is doing.

7. When the process is done, click OK.

NOTE: While the crash record is in progress, you can adjust the duration if required. Enter a new duration 
and the record duration will  update.

Ejecting Clips

To eject a clip:

1. From the Omneon ProDrive toolbar, select the Player you have configured for Clip Preparation.

2. From the Clip Prep List panel, right-click the clip you want to remove from the list and select Eject 
Clip from the menu.

Clearing Clips

To clear all clips from the Clip Preparation List panel:

1. From the Omneon ProDrive toolbar, select the Player you have configured for Clip Preparation.

2. In the Clip Preparation window button bar, click Clear List.

All clips in the Clip Preparation List panel are cleared.
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CHAPTER 7
Playing Out Clips
In this Chapter

• Overview

• Enabling a Player for Playout

• Understanding the Playout Window

• Understanding the Playout List Text File

• Managing Playlists

• Managing Playout Events

• Playing Clips

Overview

ProDrive provides comprehensive content playout features in the same user interface. Individual clips 
(or even sections of clips) can be loaded onto a port and either played out immediately or scheduled 
for playout at a specific time. 

You can also create playlists containing multiple clips from your Omneon media server. ProDrive 
supports complex transmission rules such as entire list loops, dynamically handling changes to the 
list’s contents. New clips arriving on the server can immediately be inserted into an active list at any 
desired point. 

ProDrive can also import playlists from Omneon PlayTool, making it easy to integrate into existing 
workflows or other parts of your business. 

Full logging of transmission output is provided, making it easy to compare schedules and as-run 
content – ensuring that what went to air matches what was intended. 

Enabling a Player for Playout

To enable a Player for playing out clips:

1. From the Omneon ProDrive menu bar, click Tools > Configuration.

The ProDrive Configuration window opens.

2. From the Omneon ProDrive toolbar, click a Player tab.
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3. Select the Playout option.

Table 20.  ProDrive Configuration—Player Tab 

Role
Playout

Enables the Player for automated clip playout.

Name (Optional) Assigns a name to a button that represents a Player in 
playout or ingest roles. The button appears in the Overview 
window. The default name is the one configured in Omneon 
SystemManager.

Channel Logo (Optional) Assigns a logo to the button that represents this 
Player. The logo appears in the Overview window. Click Load 
Logo to use a logo; click Clear Logo to remove it. Note that all 
images are  resized to 48 x 48 pixels. Supported file types include 
.bmp, .jpg, .tif, and .png.
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Timecode/Time of Day
Time-of-day Source

Specifies the time source used for issuing timed event commands 
such as playing or recording at a specific time of day.

• Local PC Time—uses the local time on the client PC as the 
time reference.

• Player LTC—uses the Linear timecode (LTC) of the Player 
as the time reference.

• Media Director Time—uses the media server time as the 
time reference.

• VITC Reference—uses SMPTE Vertical interval timecode 
(VITC) as the time reference. For frame accuracy, Omneon 
recommends using VITC Reference for Playout and Sched-
uled Ingest roles. Both the media server and MediaPort 
should be supplied reference from the same VITC reference 
source.

List Options • Detached Clips to keep— the number of completed items 
kept in view in the Playlist. If this is set to 5, the Playlist will 
show up to the last 5 completed or “Detached” clips.

• Clips to Preload—the number of items loaded on the 
Player’s timeline and or in cue, including the currently playing 
clip. If this is set to 5 the playlist will show one item Playing, 
and 4 Ready. Refer to About Adding Placeholder Events 
to Playlists for important information. 

GPI Triggers Use to define triggers for:
• Take
• Hold
• Recue
• Drop

You cannot reuse a port within a channel, but you can share ports 
across channels.

Note: Supports the Advantech 4751L 50pin to USB external 
device (P/N: USB-4751L-AE, 
http://www.advantech.com/products/USB-
4751L/mod_ABF6F937-9C73-4198-B3ED-
D97A611482C8:aspx. 

Default Event Properties Use to insert or add events to a playlist. This will be the default 
event type. The options are:

• Auto-Follow
• Hard-Timed
• Manual

As-Run Logs Use to define the location where you want to save the As-Run 
logs. If traffic ID exists, it will be saved to As-Run logs. See 
Table 25.

Table 20.  ProDrive Configuration—Player Tab (Continued)
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4. Configure the parameters you want.

5. Click OK.

About Adding Placeholder Events to Playlists

If a “placeholder” for a clip that is not present yet is put in a Playlist, the list will fail to start and return 
to idle state. This may occur in the following situations:

• There are several sequential placeholders all with a duration of 00:00:00:00 and no clip is defined.

• There are several sequential missing clips all with a duration of 00:00:00:00 but the clip is defined.

• Several events are dropped in order to hit a particular Hard-Timed event

To reduce the possibility of running into these issues, Omneon recommends that you set the Clips to 
Preload value to a large number such as 10.
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Understanding the Playout Window

Timecode

Playout 
Controls 

Clip Status 
Area

Button bar

Players 
Area

Playlist 
panel with 
Clips

The Playout window is arranged into different groups of controls and displays. From top to bottom, 
these are the Clip Status Area, Timecode, Playout Controls. A button bar is provided on the left side 
of the window. The Playlist panel is on the right.

Controls

Table 21.  Playout—Controls 

Shows the name of the clip.

Indicates the clip playout process is idle.

Indicates a normal operating condition.

Indicates a Warning condition that requires user intervention. For 
example, in a Playlist, an item may be cued but the Take button 
needs to be clicked. In a VTR Ingest, the Warning may be issued 
when you need to change reels. .

Indicates an Error condition that requires user intervention. For 
example, in a Playlist, the clip for the next event may be missing. 
In a VTR Ingest, the Warning may be issued because an ingest 
failed to occur, or the ingest was invalid.

Shows the status of the clip: Stopped, Paused, Forward, Rewind, 
Paused, or Playing.
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Playlist Column Layout

You can change and customize the playlist column layout.

Change Column Order

a. Left-click on column header.

b. Drag and drop the column to the new location.

Shows duration elapsed, as represented by the timecode and 
progress bar. This will be displayed as Time Count or Frame 
Count, depending on the setting used  in the General 
Configuration tab. If Frame Count is used, this will be displayed 
in frames, otherwise this is displayed as a Time counter.

Shows the duration remaining. This will be displayed as Time 
Count or Frame Count, depending on the setting used  in the 
General Configuration tab. If Frame Count is used, this will be 
displayed in frames, otherwise this is displayed as a Time 
counter..

Shows the current position of the clip in HH:MM:SS:FF 
(hours:minutes:seconds:frames). This will be displayed as 
Timecode, Time Count, or Frame Count depending on the 
setting  used in the General Configuration tab.

Starts the selected clip cued for playout..

Activates the currently loaded list. The first item in the list Cues.

Loops the playlist so that once the last event in the playlist plays, 
the first event starts playing again. If Loop is enabled then the 
List options (Detached Clips to Keep, Clips to Preload) are 
ignored.

Takes the next clip cued for playout and plays it out.

Drops the next clip cued for playout.

Holds the next clip cued for playout and waits for your action.

Recues the current clip back to the beginning of that clip.

Table 21.  Playout—Controls (Continued)
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Show and Hide Columns

a. Right-click on the column header that you want to show or hide.

b. Select the Visible Columns option from the menu.

c. Choose Reset to go back to the factory default settings.

Column changes are automatically saved and applied to all Playout channels. 

An Event List contains the following information:

Table 22.  Event List Column Descriptions

Checkbox Shows if the event is Enabled for playout:
Checked - event is enabled
Not checked - event is not enabled. The entire line will also be grayed out and 
the Status will shows Disabled.

Description Descriptive information for event added by user. This is not tied to clip 
metadata.

Clip Name Name of clip to be played for this event

Start hh:mm:ss:ff when event starts (time of day)
"If this is a Hard-timed event with a date specified, the date will appear to the 
right of the Start time mm/dd/yyyy

Stop hh:mm:ss:ff when event stops

Duration hh:mm:ss:ff for event

Type Control Type defining how this event will start (Manual, Hard, Auto)

Status Shows state of Event/Clip, possible states are:
"Ready - Event is scheduled for playback and the Clip is on the player's 
timeline but not yet cued
"Cued - Event is scheduled for playback, clip is loaded into the Player and is 
cued to the specified in point
"Playing - Clip is currently playing
"Pending - Event is scheduled for playback but the Clip is not yet on the 
player's timeline
"Detached - Event is complete
"Missing - Event is scheduled but clip is missing. This event will be skipped if 
no corrective action is taken.
"Disabled - Event is scheduled but not enabled for playout. This event will be 
skipped.

Traffic ID Shows the customer provide traffic identifier for this event/clip
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The following illustration shows an example of a playlist with clips.

Buttons

Table 23.  Playout—Buttons 

Clears the Playlist panel, enabling you to load a new playout list.

Add one or more clips to the Playlist.

Opens a playout list in the Playlist panel.

Saves the current playout list using the name and directory of your choice.

Appends the selected playout list to the current list in the Playlist panel.

Reloads the current Playlist.
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Menus

Table 24.  Playout—Menus 

File • New List—clears the Playlist panel enabling you to load a new playout list.
• Open List—opens a playout list in the Playlist panel.
• Save List—saves the current playout list using the name and directory of your 

choice.
• Exit—closes ProDrive and exits the application.

Edit • Cut—removes the selected event from the Playlist panel.
• Paste—pastes the selected event in the Playlist panel.
• Delete Events—deletes the selected Events from the Playlist panel.
• Copy—copies the selected event in the Playlist panel.
• New Event—creates a new event.
• Delete Events—deletes the selected Events from the Playlist panel.
• Edit Event—edits the selected event.
• Select All—selects all Events in the Playlist panel.

Tools • Configuration—configures ProDrive.
• VTR Control—selects the COM port through which ProDrive communi-

cates with the VTR.
• View Log—displays the event log at the bottom of the window.

Help • About—provides information about the ProDrive release.
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Understanding the Playout List Text File

Playlists can be created in ProDrive, or in an external application and imported into ProDrive. You 
can create them with a text editor, using tabs to separate the fields, and then save them with a .txt 
extension. 

A Playlist contains the following information:

The following illustration shows an example of a playout list.

NOTE: When manually creating a playlist and running with drop frame, be sure to account for drop frame in 
the start time and duration columns. Use 00:00:00;00 instead of 00:00:00:00.

Table 25.  Playlist Text File Definitions 

Clip Clipname with path.

Start hh:mm:ss:ff when event starts (time of day).

Stop hh:mm:ss:ff when event stops.

Duration hh:mm:ss:ff for event, if left blank, event uses clip duration.

TrafficID This is where the traffic sequence number should be placed.

Date yyyy-mm-dd when event is to run.

Type Trigger Type for event (Manual, Hard, Auto).

Description Descriptive information for event added by user. This is not tied to clip 
metadata.

Enabled Indicates if event should play or not (0 - enabled, 1 - disabled).

In point hh:mm:ss:ff, of clip's timecode for first frame, if left blank, event uses clip 
default In point.
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Managing Playlists

This section explains how to manage playlists and contains the following topics:

• Opening Playlists

• Appending Playlists

• Saving Playlists

• Clearing Playlists

• About Status Updates to the Playlist

Opening Playlists

To open a playlist:

1. From the Omneon ProDrive toolbar, click a Player configured for playout.

2. In the Playout window button bar, click Open List.

The Open List window opens.

3. Select your list and then click Open.

Appending Playlists

To append a playlist:

1. From the Omneon ProDrive toolbar, click a Player configured for playout.

2. In the Playout window button bar, click AppendList.

The Append List window opens.

3. Select your list and then click Append.

The list is appended to the current one in the Playlist panel.

Saving Playlists

To save the current playlist:

1. From the Omneon ProDrive toolbar, click a Player configured for playout.

2. Edit the playlist, as required.

Go to Editing Playout Events for information.

3. In the Playout window button bar, click Save List.

The Save As dialog window opens.

4. Specify a name and location for the list
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5. Click Save.

The list is saved using a name and directory of your choice.

Clearing Playlists

To clear a playlist:

1. From the Omneon ProDrive toolbar, click a Player configured for playout.

2. In the Playout window button bar, click New List.

The current list is removed from the Playlist panel and you can now open a new playlist.

About Status Updates to the Playlist

The system checks for missing clips, updates, and changes to duration and In/Out points and applies 
the following rules:

• If a clip is missing, the Status changes to Missing, in red.

• If a clip exists but is recording, the duration reflected in the event list will be equal to the current 
known duration.

• If a clip had been missing but now exists, the status will change to either Pending or Ready, 
depending on if that clip is outside or inside the Cue window (Clips to Preload).

• To ensure that you can view the active event in the playout window, configure the Clips to Keep 
value in the Player configuration to a number that will fit within the screen size that you use. 

Any time the ProDrive application is opened, and the system is configured for playout, the system will 
try to “Join” the Player’s state. Thus, if you close the ProDrive application and there are Events on a 
Player’s timeline that are being played, the next time you open the ProDrive application, ProDrive will 
try to figure out where in the Playlist you are, then join/start that list . 

• When a clip goes from Pending to Ready, the system does another check on that clip to get the 
latest information.

• If you wish to edit a clip, open the Edit window and click Ok. The system will do a check and get 
the latest information. A clip is considered edited even if you only just open the Edit window. 

Managing Playout Events

This section explains how to manage playout event. It covers the following topics:

• Creating Playout Events

• Editing Playout Events

• Copying and Pasting Playout Events

• Cutting Playout Events

• Deleting Playout Events
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• Selecting All Playout Events

Creating Playout Events

To create:

1. From the Omneon ProDrive toolbar, click a Player configured for playout.

2. Right-click anywhere in the Playlist panel and select New Event.

The Add Playout Event window opens.

3. Configure the parameters you want.

Table 26.  Add Playout Event 

Enabled Enables the Event for playout.

Description Provides a description of the Event.

Clip Name Selects the Event you want from the default directory.

Timing: Clip Type • Auto-Follow—Enables the Event to play out after the preceding 
Event finishes.

• Hard-Timed—Enables the Event to playout according to the sched-
uled start date and time.

• Manual—Enables the Event to playout only when you initiate a Take 
command. This can be accomplished using the Take button, setting a 
GPI trigger, or using the keyboard keys by clicking Ctrl + T. Manual 
events take precedence over Hard-Timed events.

Timing: Start Specifies the start time and date for Hard-Timed configured Event.

Timing: Stop Specifies the end time and date for Hard-Timed configured Event.

Timing: In Point Causes the clip to start playing from the specified point in HH:MM:SS:FF 
(hours:minutes:seconds:frames). The selected clip is cued to the specified 
timecode location.

Timing: Duration Specifies the duration of the clip playout in HH:MM:SS:FF 
(hours:minutes:seconds:frames).
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4. Click OK.

The new event is added to the Clip Playout list.

Editing Playout Events

To edit a playout event:

1. From the Omneon ProDrive toolbar, click a Player configured for playout.

2. Right-click the event you want in the Playlist panel and select Edit Event.

The Edit Playout List window opens.

3. Configure the parameters you want.

See Creating Playout Events for more information.

4. Click OK.

NOTE: There is a 5 second lockout on events. This means you cannot initiate a Drop Next or otherwise edit 
the Next event if the current event is within 5 seconds of completing.

Black can flicker on output:

Black can flicker momentarily on the output when the event following a Cued Held event is edited. 

1. Start a playlist.

2. Take the first event.

3. While the first event is playing, click Hold Next. Event #2 is now Held.

4. Wait for the first event to complete. You will see a freeze of the first frame of the clip for event #2, the 
held event.

5. Edit event #3 by doing a Drop Next, Disabling or Enabling, or editing the event to use a different 
clip. 

When any of the edits in step 5 are done, output goes black momentarily while the timeline changes 
are made.
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Copying and Pasting Playout Events

To copy and paste playout event(s):

1. From the Omneon ProDrive toolbar, click a Player configured for playout.

2. Right-click the event(s) you want in the Playlist panel and select Copy.

3. Right-click anywhere in the Playlist panel, and select Paste.

The Event(s) are copied and pasted to the Playlist panel.

Cutting Playout Events

To remove an event from a Playlist so you can paste it elsewhere, cut the event.

To cut a playout event:

1. From the Omneon ProDrive toolbar, click a Player configured for playout.

2. Right-click the Event you want in the Playlist panel and select Cut.

Deleting Playout Events

To permanently remove an event from a Playlist, delete the Event.

To delete a playout event:

1. From the Omneon ProDrive toolbar, click a Player configured for playout.

2. Right-click the event you want in the Playlist panel and select Delete Event.

A confirmation window opens.

3. Click Yes.

Selecting All Playout Events

To select:

1. From the Omneon ProDrive toolbar, click a Player configured for playout.

2. Right-click anywhere in the Playlist panel and select Select All.

All Events in the Playlist panel are now selected.
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Playing Clips

To play one or more clips:

1. From the Omneon ProDrive toolbar, click a Player configured for playout.

2. Do one of the following:

• In the Playout window button bar, click Open List.

Load the list you want to play.

• In the Playlist panel, right-click anywhere in the panel and select New Event.

Create the new Events you want to play.

3. To start playout, click Start.

4. Depending on how your event or playlist is configured, do one or more of the following:

• If the event is Auto-follow, click Take to start the first event.

• To deactivate the list and keep currently loaded clips from playing out, click Stop.

• To manually trigger the next cued Event to play, click Take.

• To drop the next clip cued for playout, click Drop Next.

• To hold the next clip cued for playout and wait for your next action, clip Hold Next.

• To recue the current clip back to the beginning, click Recue. Press TAKE to start the clip playing.
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CHAPTER 8
Managing Clips
In this Chapter

• Overview

• Viewing Clips

• Managing Clips

• Adding Custom Metadata to Clip User Data

• Managing Clip Folders

Overview

The clip management features in ProDrive help you to manage the content stored in your Omneon 
media server. With a full explorer view of the server’s contents, you can rename, move, copy and 
delete clips, all from your desktop. Even with complex reference or self-contained clips, a consolidated 
view makes your content manageable and accessible. Folder structures within the media server can 
also be created and organized with ProDrive.

Understanding the Clip Management Window

The Clip Management window displays clips for use by ProDrive. The default directory is specified 
during system configuration.
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The window contains a scrollable, multi-column list of clips in the file system. The list is arranged in 
alphabetical order and shows all clips in the current directory. You can resize the columns by clicking 
and dragging the boundary between the column headers. Click any of the columns to sort the clips 
based on what you clicked.

You can also filter the list of clips based on search criteria. In the Filter box, enter your search criteria 
to only show those clips containing the string in the name.

The default sort order when listing clips through a cliplist is newest to oldest (not alphabetical). This 
applies to:

• Clip Management

• Clip Prep - Load Clip

• Clip Prep - Add Clip

• Playout - Add Clips

Table 27.  Clip Management

Name Shows the name of the clip, along with the file extension.

Duration Shows the total clip length (regardless of stored in-points and 
out-points).

Format Shows the aspect ratio of the clip.

Framerate Shows the frame rate of the clip.

Last Modified Shows the date and time the clip was created or last modified.

FileType Shows the video file type.

Tracks Shows the number of video and separate audio channels that 
have been recorded.
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Menus

Viewing Clips

This section provides the following topics:

• Filtering Clips

• Viewing Clips in a Folder

• Viewing Clip Properties

Filtering Clips

To filter clips based on their name:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. In the Filter field, enter the search criteria you want.

ProDrive  filters the table based on your search criteria.

Table 28.  Clip Management—Menus

File • Exit—Quits ProDrive.

Edit • Delete—Deletes the selected clip.
• Rename—Renames the selected clip.
• Properties—Displays the clip’s properties.
• Select All—Selects all clips in the list.

View • Simple—Shows the default clip list.
• Complex—Allows you to independently modify essense and clip files.
• Refresh—Refreshes the list.

Tools • Configuration—Configures ProDrive.
• VTR Control—Selects the COM port through which ProDrive communi-

cates with the VTR.
• View Log—Displays the event log at the bottom of the window.

Help • About—Provides information about the ProDrive release.
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Viewing Clips in a Folder

To view a description of a clip:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. Hover the pointer over the clip you want.

A description of the clip appears in a pop-up window.

Viewing Clip Properties

To view the properties of a clip:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. Right-click the clip you want.

3. Select Properties from the pop-up menu.
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Managing Clips

This section provides the following topics:

• Selecting Clips

• Sorting Clips

• Renaming Clips

• Copying Clips

• Moving Clips

• Deleting Clips

• Changing to Complex View

Table 29.  Clip Management—Clip Properties 

Name Shows the clip name.

Type Shows the clip file type, along with the frame rate. For example, 
Quicktime Reference 29.97 fps or MXF Embedded 29.97 fps. 

Size Shows the size of the clip in megabytes.

Duration Shows the total clip length (regardless of stored in and out-
points) in HH:MM:SS:FF (hours:minutes:seconds:frames).

Last Modified Shows the date and time the clip was last modified.

Created Shows the date and time the clip was created.

In Point (SOM) Shows the in point time code.

Out Point (EOM) Shows the out point time code.

First Frame Shows the first frame of the media in HH:MM:SS:FF 
(hours:minutes:seconds:frames).

Last Frame Shows the last frame of the media in HH:MM:SS:FF 
(hours:minutes:seconds:frames).

Protected Indicates if the clip cannot be edited.

Playable Indicates the clip is ready to play.

Record in progress Indicates the clip is being recorded.

Property Lists the tracks and user data associated with the clip.

Value Lists all metadata associated with the clip such as Type, Title, 
Sample Ratio, Aspect Ratio, Channels, Sample Rate, BitRate, Bits 
per unit, Format, and Media File.
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Selecting Clips

To select one or more clips:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. Do one or more of the following:

• Use the Arrow keys to move the highlight, or click the mouse on the clip you want.

• Hold down Shift and click to select a continuous range.

• Hold down Ctrl and click to select a discontinuous range.

Sorting Clips

To sort clips by one or more criteria:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. Click the table column header you want to use to sort.

The table is sorted in ascending or descending alphabetical, numerical, or chronological order, 
depending on the selected column.

Renaming Clips

To rename a clip:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. Right-click the clip you want to rename and select Rename from the pop-up menu.

3. In the Rename file pop-up window, enter the new file name.

4. Click OK.
102 Installation and User’s Guide



  Managing Clips
Copying Clips

To copy a clip:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. Ensure the display is in Simple view. 

Tip: To change to Simple view, click View > Simple.

3. Right-click the clip you want.

4. Select Duplicate from the pop-up menu.

5. In the Duplicate file pop-up window, enter the name of the duplicate file.

6. Click OK.

ProDrive starts to duplicate the clip. The status of the “copy” operation is displayed in the status bar 
at the lower left corner of the window.

Moving Clips

To move a clip from one folder to another:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. Ensure the display is in Simple view. 

Tip: To change to Simple view, click View > Simple.

3. Select the clip you want.

4. Drag the clip to the Folders panel on the left and drop the clip on the sub-folder you want to contain 
it.
Omneon, Now Part of Harmonic 103



  Managing Clips
Deleting Clips

To delete a clip:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. Right-click the clip you want to delete.

Tip: To select multiple clips, hold down the CTRL key while right-clicking on each clip you want to delete.

3. Select Delete from the pop-up menu.

A confirmation window opens.

4. Click OK.

NOTE: If a clip’s “Protection Bit” has been set by an external application (such as an automation system), the 
system will be unable to delete the clip.

Changing to Complex View

To change the clip management display to complex view:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. From the Menu bar, select View > Complex. Click Yes in the Confirmation pop-up window.

The Clip Management window displays in complex view.
104 Installation and User’s Guide



  Managing Clips
Adding Custom Metadata to Clip User Data

Starting with release 1.1, ProDrive allows you to add custom metadata to the user data of a clip. The 
metadata is then permanently stored in the clip and can be viewed by any application accessing the 
clip. The first step is to create an XML file where the custom metadata is defined. The XML file then 
provides additional fields for user input during Crash Recording and the saving of clips.

To create an XML file:

1. Close the ProDrive application.

2. Open a text file named “metadata” and save as “metadata.xml” to the location where ProDrive.exe is 
installed. The default location is C:\Program Files\Omneon\ProDrive.

3. Open “metadata.xml” and enter text following the format in this sample:

<?xml version="1.0" encoding="UTF-8"?>

<metadata>

  />

    <item name="TYPE"

  default=""

  prompt="Enter the content type,i.e. News, Sports, CA, etc"

  displayname="TYPE"

  maxlength="20"

  />

    <item name="TITLE"

  default=""

  prompt="Enter the title here"

  displayname="TITLE"

  maxlength="20"

  />

</metadata>

Note the following:

• Item name: The key name in the user metadata. Valid characters are US ASCII only. For 
example: <item name="TYPE"

• default: The pre-filled value which appears in the text box for Crash Record or Save-As/Flatten. 
Full unicode is supported. For example: default="clip"

• prompt: The instructions which appear in the text box for Crash Record or Save-As/Flatten if no 
other data is present, and the text box is not in focus. Full unicode is supported. For example: 
prompt="Enter the content type,i.e. News, Sports, CA, etc"

• displayname: The name of the metadata field that the user will see. It appears to the left of the 
text box. Full unicode is supported. For example: Displayname="TITLE"

• maxlength: The maximum length value which defines the numbers of characters the user can 
enter in the UI. The Default is 100. For example: maxlength="20"
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To view or edit the custom metadata of a clip:

1. Launch the ProDrive application.

You can view custom metadata for a clip at any of the following locations:

Crash Record

a. Select a Player you have configured for Clip Preparation.

b. In the Clip Preparation window button bar, click Crash Record.

The Crash Record dialog opens.

The Crash Record window above shows the custom data added to the sample file in To create an 
XML file:

Save As

a. Select a clip to save.

b. The Save Clips window opens.

The Save Clips window above shows the custom data added to the sample file in To create an XML 
file:

Edit Metadata

a. Select a Player you have configured for Clip Preparation.

b. In the Clip Preparation window right click the desired clip and select Edit Metadata.
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The Edit Metadata dialog opens.

Note: Metadata can be also viewed in the tooltips on the Media Management and Clip Prep/playout 
screens.

c. Edit the text fields as required

NOTE: When editing the .mov clip’s metadata of an active ingest, you must wait until the clip ingest is 
complete. 

Managing Clip Folders

This section provides the following topics:

• Exploring Folders

• Creating Folders

• Renaming Folders

• Refreshing Folders

• Deleting Folders

Exploring Folders

To explore:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. From the Folders panel, right-click the root folder.

3. Click Explore Folder from the pop-up menu. The contents of the folder display in a Windows 
Explorer window.

Creating Folders

To create a new folder:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.
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2. From the Folders panel, right-click the folder you want to contain the new folder.

3. Click New Folder from the pop-up menu.

4. In the Add New Folder field, enter a name for the new folder.

5. Click OK.

Renaming Folders

To rename a folder:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. From the Folders panel, click  to expand the folders.

3. Right-click the folder you want.

4. Click Rename Folder from the pop-up menu.

5. In the Rename folder pop-up window, enter the new folder name and click OK.

Refreshing Folders

The Refresh Folders option refreshes the display of the "folder tree", rather than the list of files within 
a folder. To refresh, press F5 or View/Refresh from the Clip Management screen to update the folder 
tree and to refresh the clips list.
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Deleting Folders

To delete a folder:

1. From the Omneon ProDrive toolbar, click Clip Management.

The Clip Management window opens.

2. From the Folders panel, click  to expand the folders.

3. Right-click the folder you want.

4. Click Delete Folder from the pop-up menu.

A confirmation window opens.

5. Click OK.

To prevent deleting clips:

1. In Windows, click on Start > Run.

2. Enter regedit in the text field.

3. Click OK.

The Registry Editor window opens.

4. Navigate to:

My Computer > HKEY_LOCAL_MACHINE >SOFTWARE > Omneon > ProDrive > 
Config (for Windows XP)

Computer > HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > Omneon > 
ProDrive > Config (for Windows 7)

5. In the right hand panel, right click and select New > DWORD.

6. Add PreventDeletes as a DWORD value to the registry and then press Enter.

7. Double click DWORD. 

An Edit DWORD dialog opens.

8. In the Value data: type in 0 to allow deletes. Or, type in 1 to prevent deletes.

9. Click OK.

10. Close the Registry Editor.
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APPENDIX A
Reference Information
In this Appendix

• Clip Preparation Keyboard Commands

• VTR Keyboard Commands

• List Control Keyboard Commands

• About the As-Run Log Header List

• About Authentication for Omneon MediaDirector 2202 Systems Working with ProDrive

• About Fault Handling in ProDrive

• About the Automatic Renaming of Sub Clips Using Clip Patterns

Clip Preparation Keyboard Commands 

Use the following commands when doing clip preparation.

Transport Controls

Play

Key Press and Explanation

Ctrl+A

Pause k (lower case K or caps lock + K)

Pause/Play Toggle Spacebar 

Stop Shift + spacebar

Reverse (Play Reverse) j (lower case J)

Reverse faster (Play 
Reverse faster)

Press j (lower case) repeatedly (1x, 2x, 4x, 8x, 16x, 32x)

Step Back 1 frame Left arrow

Forward (Play Forward) l (lower case L) 

Forward faster (Play 
Forward faster)

Press l (lower case) repeatedly (1x, 2x, 4x, 8x, 16x, 32x)

Step Forward 1 frame Right arrow
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VTR Keyboard Commands

Use the following commands when doing VTR Ingest.

Go to In Point Shift I (upper case I)

Go to Out Point Shift O (upper case O)

Go to Previous Clip Page up

Go to Next Clip Page down

Close Crash Record Dialog Shift+click Record (button) once recording has started. 

Edit Controls

Mark In i (lower case I)

Mark Out o (lower case O)

Transport Controls

Play

Key Press and Explanation

Ctrl+A

Pause k (lower case K)

Pause/Play Toggle Spacebar 

Reverse (Play Reverse) j (lower case J)

Step 1 frame back Left arrow
Lef t arrow = 1 frame
Shifted left arrow = 5 frames
Ctrl left arrow = 1 second
Shift+ Ctrl left arrow = 1 minute

• Note that some some VTRs cannot be accurately 
“jogged in this way”; some VTRs may jog less than a 
frame, some more.

Step 5 frames back Shift + left arrow
Tape reverses 5 frames.

Reverse 1 sec. back Ctrl + left arrow
Tape reverses 1 second.

Reverse 1 min. back Shift + Ctrl + left arrow
Tape reverses 1 minute.

Forward (Play Forward) l (lower case L) 

Forward faster (Play 
Forward faster)

Press l (lower case) repeatedly (1x, 1.9x, 3.2x)
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List Control Keyboard Commands

Use the following commands to manipulate clip lists.

Step Forward 1 frame Right arrow
Right arrow = 1 frame
Shifted right arrow = 5 frames
Ctrl right arrow = 1 second
Shift+ Ctrl right arrow = 1 minute

• Note that some some VTRs cannot be accurately 
“jogged in this way”; some VTRs may jog less than a 
frame, some more.

Go to In Point Shift I (upper case I)

Go to Out Point Shift O (upper case O)

Edit Controls

Mark In i (lower case I)

Mark Out o (lower case O)

List Controls

Start/Stop List

Key Press and Explanation

Ctrl+O. Toggles between starting and stopping a Playlist.

Take List Ctrl+T 

Drop Next Event Ctrl+D 

Hold Next Event Ctrl+H. The list pauses after the current clip finished and 
you see the first frame of the Held item.

Recue Currrent Event Ctrl+R
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About ProDrive.exe Error Messages and Logs

In ProDrive, Error Logs can be manually or  generated. 

 Generated Error Messages and Logs

ProDrive generates a standard error message, shown below, if it encounters an issue which it does not 
know how to handle..

This message does not necessarily mean the application will not continue to operate correctly. When 
this message appears, click “Save bug report” and provide the requested details. Once saved, a text file 
is created which contains general details about the local PC hardware, configuration of the ProDrive 
system, error details, process, modules, call stacks that can be used to help determine the cause of the 
unexpected behavior. This file can then be sent to Omneon Technical Support, if requested.

Once the file is created, click “Continue” to close the dialog and return to the ProDrive application. If 
you continue to experience this error message, click “Restart ProDrive”.

Generating a Manual Error Message and Log

If you experience an issue with your ProDrive system that does not result in the auto-generated 
message mentioned in Generated Error Messages and Logs , you can manually generate an error 
message and save details of the system at the time of the behavior. 

To generate an error message:

1. From the ProDrive toolbar click Help > About. 

Version and licensing information appears in a dialog.

2. Press Shift*. 

A ProDrive.exe error message to appear.

3. Choose one of the following options:

• Save bug report: Enter the requested details.

• Send bug report: Generates an issue report and sends it to support@omneon.com.

• Save bug report: Saves the details of the bug report as a text file to a location you specify. You 
can enter contact information such as name, email, phone number, and facility name as well as 
notes about when the issue occurred. 

• Show bug report: Shows the information in the text file. 
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About the As-Run Log Header List

The As-run log header list is the header list for Playout As-run logs. As-run logs reside in the 
c:\Documents and Settings\User\Application Data\Omneon\ProDrive\Channel Name, where user 
is the login used to access the PC and install ProDrive, as well as the user who is currently logged in.

The As-Run file name is:
asrun-date-time.txt 

where date is the date when the schedule ran and time is the time when the schedule began.

The location of the As-Run log is defined in the Player configuration screen. See As-Run Logs. 

The following illustration shows an example of an As-Run log.

Table 30.  As-Run Column Definitions 

Event Number Item order in the playlist

Date YYYYMMDD when playlist started playing

On air Time HH:MM:SS:FF when playlist started playing

Channel Name Name of channel from ProDrive (corresponds to the player configured in 
this Role)

Play Type Control type for the event; Manual, Auto (Auto-follow), Hard (Hard-
Timed)

Actual Start Time HH:MM:SS:FF when event actually started.

Fixed Start Time HH:MM:SS:FF when event was due to start (scheduled start time).

Duration HH:MM:SS:FF (full duration of event, not clip duration).

SOM HH:MM:SS:FF of clip SOM (In-point) as played.

Clip Title Clip filename.

Status Clip status.

TrafficID Traffic Sequence number.
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About Authentication for Omneon MediaDirector 2202 
Systems Working with ProDrive

Omneon MediaDirectors support a variety of Access Control Settings, selected from the Access 
Control Screen in the SystemManager application. In general, Access Control Settings for 
MediaDirector 2202 can be configured in the same manner as you would with any other Omneon 
MediaDirector, with one exception:

• If you set the Authentication Type to LDAP and Guest Allowed to No, take these additional 
steps in the exact order:

• Mount the file system on the PC which is running ProDrive, using the CIFS user name and 
password.

• Configure ProDrive to communicate with the MediaDirector 2202.
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About Fault Handling in ProDrive

ProDrive continually sends commands to Players and monitors the return status. If a Player stops 
responding, ProDrive will report “No Comms” in the Players status for that Channel. Buttons that 
actively affect the Player, such as transport controls in Clip Prep and Start List in the Playout screen, 
are disabled.

When switching Player tabs in the Overview or Clip Management screen, an error message may 
appear if a connection cannot be made to the Player. This does not affect playout or ingest, but may 
impact operations using the GUI. If you switch to the Player channel and continue to see an error 
message, switch away from the channel and then back to it to restore the connection. If this fails, close 
and reopen ProDrive to restablish communication.

Frequently Asked Questions

What happens if the Player and/or the media server needs rebooting? 

• Due to a Spectrum Player API limitation, communication will need to be reestablished if the 
network is disabled, a cable is removed, or a Player is deactivated/reactivated through 
SystemManager.

• If a playlist is active, playout will run in the absence of communication up to the end of the 
Players’ timeline. If communication is re-established before the timeline finishes, ProDrive will 
continue seamlessly. If the timeline has finished, playout will stop, and you will need to manually 
restart ProDrive.

• If a Scheduled Ingest is active, ingests in progress run without communication. If communication 
is missing when an ingest is due to start, it will not start but will begin shortly after 
communication is restored.

• If a VTR Ingest is active the VTR Ingest "Skip/Abort/Retry" messages appears.

• Flatten/Save as operations are reliant on the Media API and as such could fail if there is no 
communication. to the media server or Player. Player control buttons such as transport controls 
are disabled if there is no communicaiton to the Player.

• For Clip Management operations, Windows error messages are used for most cases. With 
“background” operations such as copies, four retries are made and errors are shown in the 
ProDrive log file.

What happens if the PC on which ProDrive is running loses network communication to the Director?

Refer to What happens if the Player and/or the media server needs rebooting?.

What happens if the media server loses power when upgrading a Spectrum system or a similar 
situation? Do I need to reboot the media server and the MediaPorts after upgrading the firmware?

Yes, restart ProDrive once the media server has completed rebooting. 
Omneon, Now Part of Harmonic 117



  Reference Information
What happens when a MediaPort loses power or a media server loses communication with a 
MediaPort while upgrading a Spectrum system? Do I need to reboot the media server and MediaPorts 
after upgrading the firmware?

ProDrive has no knowledge of communications between a MediaPort and a media server. It does not 
report on such problems.

What happens if the media server loses communication with the Player if it’s configuration has 
changed. Do I need to deactivate a Player to change it's configuration?

Deactivating/reactivating a Player is similar to what happens if either a Player or a media server needs 
rebooting, except all clips loaded on the timeline are lost. For ingest, ProDrive restarts the ingest. For 
playout, the playout list stops and needs to be restarted.

About the Automatic Renaming of Sub Clips Using Clip 
Patterns

The Clip Name Pattern option on the ProDrive Configuration screen allows you to specify how new 
crash record clips are named. Clip Patterns can contain the following special sequences that get 
expanded as required:-

“$P” = current player name

“$D” = current date (dd-mmm-yy)

“$T” = current time (hhmmss)

“$$” = a single dollar sign

The default pattern is “$P_$D-$T_1”.

Note the behavior in the following circumstances:

• When using $P, $D, and $T in the default clip name for consecutive Crash Records where the 
Crash Record dialog remains open between ingests, default clip names with a time suffix ($T) are 
not incremented with the proper time of "now" for consecutive ingests. Instead they are auto 
incremented with a number and the suffix separator.. Refer to the following table for examples of 
the naming behavior.
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• If a clip name has a time suffix, but not a date part, the time will be treated as a six-digit sequence 
number and auto incremented without the suffix separator. For this reason, Omneon does not 
recomment using default clip names with time suffixes only.

Suffix Separator Default Name Resulting Sub Clip Name Notes

- (dash) $P-$D-$T 1st record = player-10-Jan-18-144500
2nd record = player-10-Jan-18-144500-1
3rd record = player-10-Jan-18-144500-2

Since the default name 
ends in a Date and Time, 
the entire name is 
preserved and the Suffix 
Separator is applied and 
incremented.

Blank - no value 
defined

Clip$P 1st record = Clipplayer
2nd record = Clipplayer1
3rd record = Clipplayer2

The base name "clipplayer" 
exists so the base name is 
used and incremented

Blank - no value 
defined

Clip$D 1st record = Clip10-Jan-181
2nd record = Clip10-Jan-181
3rd record = Clip10-Jan-281

Since the default name 
ends in a Date and Time, 
the entire name is 
preserved and the Suffix 
Separator is applied and 
incremented.

_ (underscore) $PClip 1st record = playerClip
2nd record = playerClip_1
3rd record = playerClip_2

The base name 
"playerClip" exists so the 
base name is used and 
incremented.

-(dash) $DClip 1st record = 10-Jan-18Clip
2nd record = 10-Jan-18Clip-1
3rd record = 10-Jan-18Clip-2

This order preserves the 
Date part of the name, then 
applies an incremented 
value to the end.

Blank - no value 
defined

$TClip 1st record = 153112Clip
2nd record = 153112Clip1
3rd record = 153112Clip2

This order preserves the 
Time part of the name, 
then applies an 
incremented value to the 
end.

-(dash) Clip$T 1st record = Clip153112
2nd record = Clip153113
3rd record = Clip153114

Since the name ends in just 
the time, the time value is 
seen as just a six digit 
number and is therefore 
incremented as a normal 
number. No suffix 
separator is used.
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viewing clips 99
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clip preparation window 65

clip preparation
Add Clip 73
adding a clip 73
buttons 69
clearing clips from clip preparation list 79
controls 66
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ejecting a clip 79
enabling 72
flattening clips 76
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merging clips 76
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recording 77
removing a clip from the list 79
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See also scheduled ingest
ingesting clips

crash record 77
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clip preparation 74

L
loading a clip

clip preparation 74

M
Media API DLL

requirement for ProDrive 17
media server

configuring 20
MediaBridge

compatibility 12
installing 12
requirements 11
starting 20

menus
clip preparation 71
playout 89

metadata
custom

adding 105
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Omneon

Technical Support 9
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clip preparation 74

P
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Player

enabling for playing clips 81
Player tab

clip preparation 72
scheduled ingest 56

playlist
clearing 92
managing 91
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saving 91

playout
Add Playout Event window 93
adding events 93

buttons 88
controls 85
copying an event 95
creating events 93
cutting an event 95
deleting an event 95
editing an event 94
enabling Player for 81
list 90
managing events 92
managing playlists 91
menus 89
pasting an event 95
playing clips 96
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selecting all events 95
window 85

ProDrive
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recording

clip preparation 77
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